
User's Guide

CABLE ID PRINTER 

CANON FINETECH NISCA INC. 2022
4Y1-8639-020

Precautions for safe use are described in the "Basic Operation Guide."
Please read it carefully before using this product.

* Please note that the contents of this manual are subject to change without notice.
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Before You Begin

Viewing This Manual

 ■ Marks

WARNING
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect 

operation of the equipment. These must be observed for safe operation.

CAUTION
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect 

operation of the equipment. These must be observed for safe operation.

IMPORTANT

Instructions including important information. To avoid damage and injury or improper use of the 

product, be sure to read these indications.

NOTE

Instructions including notes for operation and additional explanations.

 ■ About the Text

•  Copying this manual or any part of this manual without permission is strictly forbidden.

• The information in this manual is subject to change without notice.

•  We have done our best to make this manual as complete and accurate as possible, and we ask you 

to contact your place of purchase. If you fi nd any omissions or mistakes in this manual.

•  The text of this manual describes an example environment using a Windows 10. Some display 

screens and operating procedures may diff er when using a diff erent operating system.
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 ■ Abbreviations

• Microsoft Windows 11 is abbreviated as “Windows 11”

• Microsoft Windows 10 is abbreviated as “Windows 10”

• Microsoft Windows 8.1 is abbreviated as “Windows 8.1”

• Microsoft Windows is abbreviated as “Windows”

Trademarks

• Canon and the Canon logo are trademarks of Canon Inc.

•  Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the 

United States and/or other countries.

•  The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and 

any use of such marks by Canon Finetech Nisca Inc. is under license.

• eneloop is trademark or registered trademark of Panasonic Group.

•  Other brand and product names may be trademarks or registered trademarks of their respective 

companies.
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Names of Components

External View

 ■  Top View

1 2

3

4

5

1  Keyboard

2  Cover

3  Power key

4  AC adapter connector

5  USB connector (Type-B)

 ■ Bottom View

1

2

3

1  Battery cover

2  Battery case

3  Rating plate *

* The rating plate shows the 

manufacturer, model name, 

electrical rating, and serial number.
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 Inside View

2

3

4

5

6

7

8

10

11

9

1

12

13

14

1  Connector for tube warmer

2  Attachment/Media cassette mount

3   Media feed port (When the 
attachment installed)

4  Display

5 Ribbon cassette mount

6  Transport roller 1

7  Print head

8 Transport roller 2

9 Transport roller 3

10   Connector for ribbon cassette

11  Cutter

12  Media delivery port

13  Blade receiver

14  Jam recovery lever
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  Tube Attachment

3

1 2 1  Size switch lever

2  Tube retainer lever

3  Cleaner
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 Names and Functions of  Keys

1 2 3 4 5 6 7 8 10 11 12 13 14 15 16 17 18 199

202122232425262728

1  [Page] key This key allows you to check the page number of the currently 

displayed page and the total number of pages in the data. You 

can also check the remaining memory capacity of the printer. 

(P.36)

2  [ ] key Specifi es the page orientation (portrait/landscape) and text 

direction (portrait/landscape). (P.45)

3  [Seg Len] key Specifi es the length of one tube (or one label), character 

alignment, and margins. (P.54)

4  [Frame] key Sets a frame around the text. (P.44)

5  [Char Size] key Sets the character size. (P.42)

6  [Set Lines] key Sets the number of lines. (P.48)

7  [Char Space] key Sets the space between characters. (P.47)

8  [Edit] key Edits a page. (P.65)

9  [Cont Print] key Sets up repeat printing of a page. (P.84)

10  [Num] key Sets numbering for text. (P.49)

11  [File] key Sets up the saving and loading of data. (P.102)

12  [Connect] key
Sets the connection method when printing from a PC (P.122) 

or tablet device (P.204).
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 13  [Warmer] key Switches between tube warmer settings (optional). (P.9)

14  [Settings] key All functions can be set using this key. (P.231)

15  [Del All] key Deletes the currently entered characters and settings. (P.41)

16  [Ins] key Switches between Insert mode and Overwrite mode. (P.37)

17  [Del] key Deletes the character selected by the cursor. (P.40)

18  [Canc] key Press this key while printing to stop printing, and then stop 

after cutting the print media. If you press and hold this key for 

2 seconds or more, the printer will stop without cutting.

If pressed during the operation of a function, the operation will 

be canceled. Also, pressing this key while holding down [Shift] 

will return you to the character input display.

19  [Back Space] key Deletes the character to the left of the cursor position. (P.40)

20  [Enter] key Confi rm the input of unconfi rmed characters or selected items. 

Pressing this key after fi nalizing text input will insert a page 

break at the cursor position. (P.65)

21  [  ][  ][  ][  ]
( Arrow keys)

Move the cursor or selected item up, down, left or right. If you 

press this key while holding down [Shift] in the character input 

display, you can move to the next or previous page. (P.37)

22  [Print] key Displays the printing preference display and allows you to 

print the currently displayed data. (P.77)

23  [Set Cut] key Sets the cut method for printing. (P.92)

24  [Adjust] key Adjust the print position and cut length (P.85), and adjust 

the cutter (P.96).

25  Space key Enter a space.

26   [Symbol 1] key,
[Symbol 2] key

Enter a symbol (P.39). Use the [Alt]+[Enter] keys to confi rm 

the selected unconfi rmed symbol.

27  [Remove] key This key is used to remove the tube or label tape from the 

printer. (P.27)

28  [Caps Lock] key
If you press this key and then enter alphanumeric characters, 

they will be capitalized. (P.38)

NOTE

• In this manual, pressing and holding down [Shift] (or [Alt]) and pressing the desired key will perform 

the following operations.

Example: [Shift] + [Canc] keys
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 How to Read the  Display

H /  H

Prev

Caps PWR Warmer

Frame Char Size

Char Space#Line

NextPage Cont PrintA/ A

Seg Length  AlignINS

Remaining Ink Ribbon

Half Cut

Print Speed

2 3 4 5 6 7 8

1011

9

131415 1216

1

 1  Caps Lock Indicates whether the Caps Lock mode is active.

:  Active, so all alphabetic characters are entered in 

uppercase.

(No indication): Normal (inactive).

 2  Insert/ Overwrite 
mode

Indicates which of the two input modes is selected. (P.37)

:  Insert mode

(No indication): Overwrite mode

3  Print speed Displays the printing speed settings. (P.91)

H: High   M: Middle   L: Low

4  Half cut setting The settings for adding a half cut to tubes or label tapes are 

indicated by the following symbols. (P.92)

: Half cut.

:  Not half cut, but a solid line is printed showing 

where to cut with scissors, etc.

:  Not half cut, but a dotted line is printed showing 

where to cut with scissors, etc.

(No indication) :  Not half cut, and no cutting line is printed.
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5  Remaining ribbon Indicates the remaining capacity of the ink ribbon with a mark.

(Ribbon remaining)

.

.

.

(Out of ribbon)

:  The display changes every 10%. When the 

remaining capacity is low, prepare a new 

ribbon cassette.

(Not displayed) :  The ribbon cassette is not loaded, or the 

information cannot be read.

6  Power The power source being used is indicated by the following 

symbols. (P.12)

: The AC adapter is being used.

(Power remaining)

.

.

.

(Out of power)

:   When the battery is being used, the 

remaining battery charge is indicated by 

this symbol. 

(If the battery is not suffi  ciently charged, 

the remaining capacity may not be 

displayed correctly.)

 7 Warmer  Displays the  settings for the (optional) tube warmer. (P.31)

Auto :  Only warms the tube during printing. When 

printing is executed, the tube will be warmed 

up to the set temperature, and then printing 

will start.

RDY :  Warms the tube except while printing. 

When printing is executed, it starts printing 

immediately. "WAI" will be displayed when 

the set temperature is adjusted.

OFF : Disables the tube warmer settings.

(No indication) : The tube warmer is not set.
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8   Cut Length/
 Alignment/Margin

Displays the settings for the length (cut length) of a tube (or a label), 

alignment, and margin of the current page. (P.54)

• When using the "Automatic" cut length feature (The set 

value is highlighted.)

Cut Length (mm) Alignment (Centered “C” )

• When using the "Specify" cut length feature

Margin (mm)
( “E” when “Expansion” is selected 
   on the Plate Printing Area)

Cut Length (mm) Alignment (Centered “C”,  Left-aligned “L” ,  
         Right-aligned “R” , Even Distribution “E” )

9  Cursor Text is entered at the position indicated by a . (P.37)

10  Cont Print Displays the number of times the current page will be printed 

repeatedly. (P.84)

11  Character Space Displays the character space setting for the current page. 

(P.47)

12  Lines Displays the number of lines setting for the current page. 

(P.48)

13  Character Size Displays the character size setting for the current page. (P.42)

14  Frame Displays the frame setting for the current page. (P.44)

15  Orientation Displays the print orientation and character orientation settings 

for the current page. (P.45)

16  Page Displays the page number of the current page. (P.36)

:  Displayed when there is a page before the current page.

:  Displayed when there is a page after the current page.

NOTE

• This product treats the string of characters to be printed on one tube (or one label) as one page. Press 

the [Enter] key to create a new page. (Page Break)

For more information on page manipulation and editing, refer to "Creating and Editing Pages 

(P.65)".
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 Preparing the  Power Supply

 Connecting the AC Adapter

CAUTION
• Be sure to use the supplied genuine AC adapter and power cord.

1 Connect the  power cord to the  AC adapter, and plug the AC adapter into the 

printer.

2 Insert the power plug into a power outlet.

IMPORTANT

• If the AC adapter jack is defective or damaged, it cannot be repaired. Please purchase the AC adapter 

from your point of purchase for this product.
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 Use with  Batteries

If you are outdoors or in any other place where you do not have access to a power supply, you 

can use the product with batteries.

CAUTION
• Be sure to use fully charged "eneloop AA Standard Model Batteries (Part No. : BK-

3MCCA (for North America), BK-3MCCE (for Asia)." Do not use any other type of 

battery. Failure to do so may result in fi re, malfunction, or injury.

1 Prepare 6 "eneloop AA Standard Model Batteries (Part No. : BK-3MCCA (for 

North America), BK-3MCCE (for Asia)" (Sold separately).

2 Make sure that the power is turned off .

3 Remove the battery cover.

4 Insert the batteries.

 ● As shown in the fi gure,  insert the battery 

terminal into the printer, and  push it in.

 ● Paying attention to the direction in which you 

insert the batteries, as marked with the  and 

 symbols.

●
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5 Put the battery cover back on.

 ● Push the battery cover in until it clicks into place, 

and close it completely so that there is no gap 

between the battery cover and the printer.

IMPORTANT

• If the product has batteries installed and the AC adapter is also plugged into a power outlet, the AC 

adapter will be given priority as the power supply. However, it is recommended that you remove the 

batteries when using the AC adapter, as they will be drained otherwise.

• If the batteries are installed and the AC adapter is connected to the product, do not disconnect the AC 

adapter during printing. The product will not be able to print properly if you do so.

• When printing using battery power, even if the AC adapter is connected during printing, the power 

supply will not be switched until printing is fi nished.

• The remaining battery power cannot be displayed correctly directly after switching the power supply 

from the AC adapter to the batteries. Once printing starts, the remaining capacity will be updated.

• When using the (optional) tube warmer or when printing large characters (character size: 6mm full-

width), the batteries will be drained quickly. In such cases, we recommend the use of the AC adapter.
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 Turning the Printer On/Off 

 Turning the Printer On

1 Press and hold the  power key for 1 second or more.

 ● When the power is turned on, the screen are 

switched in the order "Startup display">"Ribbon 

cassette information display">"Character input 

display."

 ● If the power is turned on without a ribbon 

cassette loaded, the ribbon cassette information 

display will not be displayed.

"  Startup display"

" Ribbon cassette information 

display"

Ribbon information
black     40m

" Character input display"

 ● If there is any data that was displayed when 

the power was last turned off  (or automatically 

turned off ), a screen will appear to confi rm 

whether you would like to delete the data. If 

you press [Yes], the character input display will 

appear with the data erased.

The data  being
edited remains .
Erase i t?

Yes No
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NOTE
• Hide the initial delete check message

You can choose not to display the screen to confi rm the deletion of data upon startup. When set to 

"No," the program will start without deleting the data being edited.

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Other," and then press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3   Use [  ] or [  ] to select " Init. DeleteCheck" and press the [Enter] key.

Print priority
Init. DeleteCheck
Page Display

Others

4  Use [  ] or [  ] to select "No," and then press the [Enter] key.

Yes
No

Init. DeleteCheck

5 Press the [Shift]+[Canc] keys.

 ● You will return to the character input 

display.



17

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g

  Turning the Printer Off 

1 Press and hold the  power key for 1 second or more.

 ● The "Shutting down..." message will 

be displayed, and then the printer 

will turned off .

2 Unplug the power plug from the power outlet.

CAUTION
• When disconnecting the AC adapter from the printer, be sure to remove the power 

plug from the power outlet fi rst.

IMPORTANT

• Do not disconnect the power plug until the power has been completely turned off .

• If you will not be using the printer for a long period of time, remove the power cord, AC adapter, USB 

cable, and batteries from the printer.

NOTE

• This product has a function that automatically turns off  the power when a certain amount of time 

passes without printing. For details, refer to "Changing the Auto Power Off  Settings (Adapter/

Battery) (P.193)".
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 Installing the Ribbon Cassette

IMPORTANT

• When printing on a plates, use a black, 40m ribbon cassette. Other ribbon cassettes (black, 150m; 

white, 85m) will not print correctly.

• For more information on the ribbon cassette that can be used, refer to "Consumable Supplies and 

Options (P.229)".

• Dispose the used ribbon cassette according to local government regulation.

1 Open the cover.

2 When replacing the ribbon cassette, remove it from the printer.
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3 Remove the new ribbon cassette packing material.

IMPORTANT

• Do not touch the IC chip on the ribbon cassette. Doing so may 

render the ribbon cassette information unreadable.

 4 Remove any slack in the ribbon.

IMPORTANT

• If the ribbon is loose, it may not operate properly.
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5 Install the ribbon cassette into the printer.

 ● Push the cassette in until it clicks into the place.

IMPORTANT

• If the ribbon cassette is slack, it may not operate properly.

6 Close the cover.
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 Loading the Print Media

 Loading a Tube or Plate

IMPORTANT

• Do not use the following types of tubes. Not only will the product not print cleanly, but use with such 

tubes may also cause a malfunction.

 - Broken - Crushed - Twisted - Uneven thickness

 - Soiled - Uneven - Wet

• You cannot print on dirty tubes or plates. Wipe off any dirt or dust with a dry cloth. Also, do not use 

tubes or plates that have oil or other stains that cannot be wiped off.

NOTE

• Please purchase commercially available tubes and plates for use. For more information on the sizes 

that can be used, refer to "Print Media (P.228)".

• The procedure for removing set print media from the printer, please refer to "Replacing the Print 

Media (P.27)".

• Periodically clean or replace the cleaner of attachment. Dirt on the cleaner will cause print smears. For 

details, refer to "Cleaning/Replacing the Cleaners (P.188)".

1 Prepare the attachment.

 ● For tubes (round)

Use the  cleaner (blue) by attaching it to the  tube attachment.

 ● For flat tubes

Use the cleaner (blue) by attaching it to the (optional)  plate and flat tube attachment.
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 ● For plates

Use the  plate cleaner (gray) by attaching it to the (optional)  plate and flat tube 

attachment.

2 Open the cover.

3 Install the attachment into the printer.

 ● Align the attachment with 

the slot on the printer and 

push it in fi rmly until it clicks 

into place.

 4 Set the  size switch lever to match the size of the tube (or the plate size).

 ● For plates, set it to 

"ø2.6mm - ø10.0mm."
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 5 Insert the tube (or plate).

 ● For tubes (round)

Insert the tip of the tube  into 

the  media feed port in the 

direction shown in the figure, 

and push it in until it hits 

transport roller 2.
Transport roller 2

 ● For plates and flat tubes

Insert the tip of the plate (or 

flat tube) into the media feed 

port in the direction shown 

in the figure, and push it in 

until it hits transport roller 2.

Transport roller 2

NOTE
• If it is diffi  cult to pass the tube (or plate) through the 

attachment, set the tube (or plate) in place while pressing 

the  tube retainer lever with your fi nger.

IMPORTANT

• If the tip of the tube (or plate) is inserted as shown in the 

fi gure, the tube (or plate) may get stuck during printing, 

the print may be chipped, or the cut position may be off .

• If the tip of the tube (or plate) is bent due to winding, etc., fi x it so that it is straight, or cut off  the bent 

portion before placing it in the printer.

• To prevent the print media from running out during printing, or to prevent the shortened print media 
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from getting stuck inside the printer, use a tube (or plate) of suffi  cient length.

• If the tube (or plate) is not set correctly, this device may print onto the transport roller.

6 Close the cover.
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 Loading a  Label Tape Cassette

IMPORTANT

• Dispose the used label tape cassette according to local government regulation.

NOTE

• The procedure for removing set print media from the printer, please refer to "Replacing the Print 

Media (P.27)".

1 Check the condition of the cassette.

 ● If the release paper has a high spot, or the tips 

are not aligned, cut that portion off .

 ● Pull out the end of the tape by about 

5 mm to 7 mm as shown in the fi gure.

NOTE
• If label tape or other material has gotten into the 

cassette, use tweezers to pull out the tape tip, as shown 

in the fi gure.

2 Open the cover.
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3 Install the cassette into the printer.

 ● Align the cassette with the 

slot on the printer, and push 

it in fi rmly until it clicks into 

place.

4 Close the cover.



27

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g

 Replacing the Print Media

To replace the print media installed in the printer with a diff erent one, follow the procedure 

below.

NOTE

• For information on the print media that can be used with this product, refer to "Print Media (P.228)".

 ■  For Thin Tubes (ø1.5 mm)

1 Open the cover.

2 As shown in the fi gure, pull the tube out while pressing the  jam recovery 

lever in the direction of the arrow.

3 Load the print media. (P.21)
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 ■ For Other Print Media

1 Turn on the power. (P.15)

2 Press the [Remove] key.

 ● The following screen will be displayed.

3 Select "Yes" with [   ] or [   ] and press the [Enter] key.

 ● The print media will be rotated backwards.

Unload print media?

Yes No

Unloading…

4 Open the cover.

5 (When using a tube or plate)

 Pull out the tube (or plate).

 ● If the tube (or plate) cannot be removed, close 

the cover and press the [Remove] key again.
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6 Remove the attachment (or media cassette, tube warmer).

 ● When using the attachment or media cassette.

While pulling the lever to the right, lift it upward 

to remove it.

 ● When using the tube warmer.

Grasp the tube warmer while pushing its two 

stoppers and pull it straight upward.

IMPORTANT

• Do not lift the tube warmer diagonally. It may damage the connector on the bottom of the tube 

warmer.

NOTE

• Keep the media cassette with the slack of the tape removed.
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7 Load the print media. 

 ● When using a tube or plate, refer to "Loading a Tube or Plate (P.21)".

 ● When using a media cassette, refer to "Loading a Label Tape Cassette (P.25)".

IMPORTANT

• When the print media feed is reversed, the ribbon in the ribbon cassette may become slack. If the 

ribbon is slack, remove the ribbon cassette and remove the slack in the ribbon. (P.19)

• For soft tubes, using the [Remove] key to feed backwards may damage the tube. In such cases, follow 

the procedure described in "For Thin Tubes (ø1.5 mm) (P.27)".
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 Using the (Optional) Tube Warmer

The tube warmer is an attachment that warms up tubes that have become stiff  at low 

temperatures to make them easier to print on and feed into the printer.

CAUTION
• Do not leave the tube warmer heated with a tube set in it. Excessive heating of a 

tube may cause a fi re.

• Do not put your fi ngers in the tube warmer's tube insertion and tube delivery ports. 

Doing so may result in burns.

 Set the Tube in the  Tube Warmer

IMPORTANT

• The tube warmer can be used with the following tube types and sizes. This device cannot print 

correctly on other types of tubes. 

Type: Tube, clear tube

Size: ø1.5 to ø6.5 mm internal diameter

• If the tube gets too warm, the device may not print on it correctly. Print as soon as possible after 

loading the tube.

• Do not use the following types of tubes. Not only will the product not print cleanly, but use with such 

tubes may also cause a malfunction.

- Broken   - Crushed   - Twisted   - Uneven thickness

- Soiled   - Uneven   - Wet

• It is not possible to print on dirty tubes or plates. Wipe off  any dirt or dust with a dry cloth. Also, do not 

use tubes or plates that have oil or other stains that cannot be wiped off .

• If the tube warmer cleaner is dirty, it may cause blurred printing. Clean or replace it periodically. For 

more information, refer to "Cleaning/Replacing the Cleaners (P.188)".

NOTE

• For information on how to remove a tube that has been set into the printer, and on how to remove 

the tube warmer, refer to "Replacing the Print Media (P.27)".
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1  Prepare the tube warmer.

2  Open the cover.

3  Set the tube warmer in place.

 ● Insert the connector of 

the tube warmer into the 

connector for the tube 

warmer on the printer and 

push down on it vertically 

until it clicks into place.

4  Set the  size switch lever to match the size of the tube, and set the tube. 

(P.22)

 ● Set the tube in the same way as when using the tube attachment.
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5  Close the cover.

6  Turn on the printer. (P.15)

7  Check the control settings of the tube warmer.

 ● The current control settings of the warmer will 

be shown on the display.

 ● The control settings of the warmer can be 

switched between Auto (automatic), WAI or 

RDY (ON), and OFF (OFF). These options can be 

cycled through in that order be pressing the 

[Warmer] key. (P.7)

IMPORTANT

• When the tube warmer is not set, the tube  warmer control settings are disabled.

• If you cannot print correctly even with the tube warmer (for example, printing is blurred), change the 

temperature setting of the tube warmer. (P.34)

NOTE

• When "Label," "Plate," or "Wrap Around" is selected for the print media in the print settings, and "ON" is 

selected, "OFF" will appear on the display. To change the print media, press the [Print] key. (P.77)
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 Changing the Temperature Setting of the Tube Warmer

If you cannot print correctly even with the tube warmer (for example, printing is blurred), change 

the temperature setting of the tube warmer. The default setting is "Mid."

[Example]  Printing is blurred, so set the tube warmer temperature to "High."

1  Turn on the printer. (P.15)

2  Press the [Settings] key.

3  Use [  ] or [  ] to select "Warmer," and then press the [Enter] key.

Sett ings
Connect
Warmer
Character  Edit

4  Use [  ] or [  ] to select " Warmer Temp.," then press the [Enter] key.

Warmer

Warmer Control
Warmer Temp.

5  Use [  ] or [  ] to select "High," then press the [Enter] key.

 ● The temperature can be adjusted to three levels: 

"High," "Mid," and "Low.
Warmer Temp.

High
Mid
Low

NOTE

• We recommend using the AC adapter when printing with the tube warmer, as it drains the batteries 

quickly. Also, if you want to print with less battery drain, set the warmer temperature to "Low."
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 Basic Input Operations

 Before Input

 ■  About Pages

This product treats the string of characters to be printed on one tube (or one label) as a single 

page. Press the [Enter] key to create a new page. ( Page Break)

200V

0001

Pump Room

0002

C1

0003

200V

(Page 1)

Pump Room

(Page 2)

C1

(Page 3)

Press

[Enter] key

Press

[Enter] key

200V Pump Room C1

Also, if you press the [ Page] key, you can check the page number of the currently displayed page 

and the total number of pages in the data. In addition, " Memory used" allows you to check the 

available space on the character input display. Press any key to return to the character input 

display.

Page Display
  Page      41 of 53
Memory used

 The page number of the currently 

displayed page/ the total number of pages 

Currently used capacity

The available space on the character input display
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 ■  How to Use the  Cursor

The mark that indicates the position for entering text is called the "cursor." 

Use the  arrow keys ([  ], [  ], [  ], [  ]) to move the cursor when using this device. The key 

operations for moving the cursor are as follows.

Key press Cursor movement

[   ] Move to right one character or to the next page.

[   ] Move to left one character or to the previous page.

[  ] Go to the line above.

[  ] Go to the line below.

[Shift] + [  ] Go to the top of the page.

[Shift] + [  ] Go to the end of the page.

[Shift] + [   ] Go to the top of the previous page.

[Shift] + [   ] Go to the top of the next page.

 ■  Insert Mode and Overwrite Mode

You can switch between "Insert Mode" and "Overwrite Mode" to suit where you want to input 

text. Press the [Ins] key to switch between "Insert Mode" and "Overwrite Mode."

 Insert Mode:

When you move the cursor to the middle of a text string and input a character, the input 

character will be inserted to the left of the cursor position.

AB  DEC

INS INS

ABA  DEC

 Overwrite Mode:

When you move the cursor to the middle of the text and enter a character, the character at the 

cursor position will be overwritten with the character you entered.

INSINS

AB  DEC ABA  ED
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 Entering Text

[Example] Input "Res7-1."

1  Input "Res7-1."

 ● Enter [Shift]+[R], [E], [S], [7], [-], and [1] in this 

order.

 ● When entering capital letters, hold down [Shift] 

and press the desired key.

 ● If you make a mistake, use the [Back Space] 

key to delete the character, and then enter the 

correct character. (P.40)

NOTE

• Press the  [Caps Lock] key to switch to the uppercase alphabet input mode. To return to the previous 

mode, press the [Caps Lock] key again.

Caps

ABC
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  Entering Symbols

You can use the input symbol function to enter symbols that cannot be entered using the 

keyboard.

[Example] Input "Ω."

1  Press the [Symbol 1] key.

2  Use the arrow keys ([  ], [  ], [  ], [  ]) to select "Ω" from the list of symbols.

 ● The symbol screen is divided into two groups. To 

switch between groups, press [Shift] + [  ] (or 

[  ]).

 ● For symbols that can be entered, see "List of 

Symbols (P.233)".

3  Press the [Enter] key.

 ● "Ω" will be displayed at the position indicated by  

" ".

 ● If you want to delete the character displayed at 

the position indicated by " ", press the [Back 

Space] key while holding down [Alt]. You can 

also move the cursor by pressing [  ] or [  ] 

while holding down [Alt].

4  Press the [Alt] + [Enter] keys.

 ● "Ω" will be entered.
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 Deleting Characters

There are two ways to delete a character: using the [Back Space] key or using the [Del] key.

 ■  Deleting with the  [Back Space] key

[Example] Change "27V" to "2V."

1  Move  (the cursor) to "V."

2  Press the [Back Space] key.

 ● The character to the left of the cursor position 

will be deleted.

 ■  Deleting with the  [Del] key

[Example] Change "27V" to "2V."

1  Move  (the cursor) to "7."

2  Press the [Del] key.

 ● The character at the cursor position will be 

deleted.
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 Deleting All Characters That Have Been Entered

This deletes all the characters entered in the page. ( Delete All)

For Delete All, select one of the following.

Text only:

Delete all pages of text, leaving the format setting of the last page.

Text+settings:

Reset the character size and other format settings to their default values, and delete text from all 

pages.

NOTE
•  About  Format Settings

 "Text+settings" returns the format settings to their default values. Format Settings in this product 

refers to the following function settings.

Function name Default setting Function name Default setting

Character Size 3 mm full-width All line centering Off 

Frame None Orientation Hor/Hor char

Cut Length Automatic Continuous Print Off  (one time)

Alignment Centered Character Space Narrow

Plate Print Area Normal Lines 1 line

[Example]  Delete all pages of input text and restore the character size and other format 

setting to their default values.

1  Press the  [Del All] key.

2  Use [  ] to select "Text+settings," and press the [Enter] key.

 ● A confi rmation screen will appear. Delete All

Text only
Text+settings

3  Select "Yes" with [   ] or [   ] and press the [Enter] key.

 ● The display returns to the character input 

display.
Delete text and
reset settings?

Yes No
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 Editing Characters and Lines

 Setting the  Character Size

This is how the character size is set. The character size can be selected from those below; the 

default value is "3 mm full-width."

6 mm
half-width

6 mm 
full-width

200V
200V

4 mm
half-width

4 mm
full-width

200V

200V

3 mm
half-width

3 mm
full-width200V

200V

2.6 mm
half-width

2.6 mm 
full-width

200V

200V

1.3 mm 
full-width

2 mm 
half-width

2 mm 
full-width

200V

200V

200V

[Example] Set the character size to "3 mm half-width."

1  Display the page where you want to change the character size.

2  Press the [Char Size] key.

3  Use [  ] or [  ] to select "3 mm half-width."

 ● "×" will appear next to character sizes that 

cannot be selected.
Character Size

3  half-width
3  full-width
4  half-width

4  Press the [Enter] key.

 ● The display returns to the character input 

display.

 ● The character size setting can be checked on the 

display.

 ● If you select "half-width," the text will be 

displayed in half-width.

3mm
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NOTE

• The character size can be set for each page.

• Even if you select half-width characters, symbols will be printed in full-width.

• Some character sizes cannot be selected depending on the number of lines, the cut length setting, 

and the size of the print media.

• No error message will be displayed even if the print data extends beyond the width (top and bottom) 

of the print media. Refer to the following to set the character size and frame.

  Maximum Printable Character Size

Print Media  Maximum Printable Character Size

Type Size (mm) Without frame (mm) With frame (mm)

Tube

Clear tube

Shrink tube

1.5 1.3
× 

(printing not possible)

2.5 2.6 1.3

3 3 2.6

4 4 4

5 6 4

6 6 6

6.5 6 6

7 6 6

8 6 6

9 6 6

10 6 6

Flat tube
1.5 1.3

× 
(printing not possible)

2.5 1.3 1.3

3 4 2.6

4 4 3

5 6 4

6 6 6

6.5 6 6

Label 6 3 2

9 6 4

12 6 6

Plate 8 4 4

8.5 4 4

9 6 4

9.5 6 4

10 6 6
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 Surround Text with a Frame

This allows you to surround text with a  frame. The following frame shapes are available, with the 

default value set to "None."

Pump Room Pump Room Pump RoomPump Room Pump Room

[Example] Enclosing text in a  frame.

1  Display the page where you want to change the frame settings.

2  Press the [Frame] key.

3  Use the arrow keys ([  ], [  ], [   ], [   ]) to select  from the list of 

frames.

Frame
None

4  Press the [Enter] key.

 ● The display returns to the character input 

display.

 ● The frame shapes setting can be checked on the 

display.

NOTE

• The frame can be set for each page.

• When the cut length is specifi ed, the frame may not be set.

• Depending on the settings of the number of lines, character size, cut length, etc. and the size of the 

print media, the frame may not be printed correctly.

• No error message will be displayed even if the print data extends beyond the width (top and bottom) 

of the print media. Refer to "Maximum Printable Character Size (P.43)" for information on 

character size and frame settings.
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 Specifying the Orientation and Character Direction

The orientation (Vert/Hor) and text direction (Vert char/Hor char) are specifi ed in the 

"Orientation" settings. The default setting is set to "Hor/Hor char."

Setting Details Print Image

Hor/Hor char 

(Default Setting)

Orientation: horizontal

Text direction: horizontal
12V
24V Pump Room C1 

Vert/Vert char
Orientation: vertical

Text direction: vertical

C 12 4 V

1 2 V

P u m p  R o o m

Vert/Hor char
Orientation: vertical

Text direction: horizontal

B1 C
1A1 A2

[Example] Set to "Vert/Vert char."

1  Display the page for which you want to change the  orientation.

2  Press the [ ] key.

3  Use [   ] or [   ] to select "Page."

 ● If you select "All" in this screen, the orientation of 

all pages will be changed.
Orientation  Page /All

Hor/Hor   char
Vert/Vert char
Vert/Hor  char

4  Use [  ] or [  ] to select "Vert/Vert char."

 ● "×" will appear next to orientation that cannot 

be selected. Hor/Hor   char
Vert/Vert char
Vert/Hor  char

Orientation  Page /All
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5  Press the [Enter] key.

 ● The display returns to the character input 

display.

 ● The orientation settings can be checked on the 

display.
V        V 

NOTE

• The orientation can be set for each page.

• If you change the orientation, a confi rmation message will appear if any characters do not fi t within 

the page. To cancel the changes, select "No."

• If you want to set the orientation to "Vert/Hor char," set the orientation before entering text. It is not 

possible to specify "Vert/Hor char" for the text you input.

• If you set the orientation to "Vert/Hor char," the settings will be as follows.

 - The character space is set to "Narrow" and cannot be changed.

 - The text will be printed centered even if the alignment is set to "Even Distribution."

 - Regardless of the "All line centering" setting, all lines will be centered and printed.

 - The center line will not be printed regardless of the Center Line setting.
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 Specify the Character Spacing

Sets the space between characters. The default setting is set to "Narrow."

Setting Details Print Image

Narrow 

 (Default Setting)
No character spacing Pump Room

Medium Character spacing 0.5 mm Pump Room

Wide Character spacing 1.0 mm P u m p  R o o m

[Example] Setting the  character spacing to "Wide."

1  Display the page where you want to change the character spacing.

2  Press the [Char Space] key.

3  Use [  ] or [  ] to select "Wide."

 ● "×" will appear next to character space that 

cannot be selected.
Character Space

Narrow
Medium
Wide

4  Press the [Enter] key.

 ● The display returns to the character input 

display.

 ● The character space settings can be checked on 

the display.

NOTE

• The character space can be set for each page.

• When the cut length is specifi ed, the character space may not be changed.

• If the alignment is set to "Even Distribution," the Even Distribution setting will take priority even if the 

character space is set.

• When the orientation is set to "Vert/Hor char," the character space cannot be set.
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 Specifying the Number of  Lines

Sets the number of lines. The default setting is "1 Line."

Setting Details Print Image

1 Line (Default Setting) Input in one line 12V

2 Lines Input in two lines 12V
24V

3 Lines Input in three lines
+12V
-12V
200V

[Example] 2 line input.

1  Display the page where you want to change the number of lines.

2  Press the [Set Lines] key.

3  Use [  ] or [  ] to select "2 Lines."

 ● "×" will appear next to the number of lines 

that cannot be selected.
Lines

1 Line
2 Lines
3 Lines 

4  Press the [Enter] key.

 ● The number of lines setting can be checked 

on the display.

 ● Use the arrow keys ([  ], [  ], [  ], [  ]) to 

move between the lines.

NOTE
• The number of lines can be set for each page.

• When the character size is set to "1.3 mm full-width," "2 mm full-width," or "2 mm Half,” the text can 

be printed in three lines. If you want to print in three lines, set the character size before selecting the 

number of lines. (P.42)

• If after entering text, you would like to reduce the number of lines, delete the second (or third) line of 

text and then change the line number setting.

• You may not be able to select "2 Lines" or "3 Lines" depending on the selected character size.

• No error message will be displayed even if the print data extends beyond the width (top and bottom) of 

the print media. It is recommended that you refer to the preview to make sure that no characters are 

missing before printing. (P.81)
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  Numbering

You can print a fi xed string of characters with a sequential number or letter of the alphabet. The 

possible numbering settings are as follows.

Setting Set range Print Image

Decimal 0 to 9999 Pump Room 1 Pump Room 2 Pump Room 3 

Hexadecimal 0 to FFFF Pump Room 09 Pump Room 0A Pump Room 0B 

Upper case letter A to Z Pump Room A Pump Room B Pump Room C 

Lower case letter a to z Pump Room a Pump Room b Pump Room c 

Example: Set the numbering from 1 to 10 after "Pump Room."

……Pump Room 1 Pump Room 2 Pump Room 3 Pump Room 10

1  Enter "Pump Room."

 ● Move the cursor to the position where you 

want to enter the number.
P u m p  R o o m

2  Press the [Num] key.

3  Use [  ] or [  ] to select "Decimal Settings," and press the [Enter] key.

Number Settings
Decimal Settings
Hexa Settings
A to Z Settings

4  Use [  ] or [  ] to select "Start value," and then enter "1."

Decimal Settings
Start value: 1
End value  : 0
[ 0  to  9999 ] 
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5  Use [  ] or [  ] to select "End value" and enter "10."

Decimal Settings
Start value: 1
End value  : 10
[ 0  to  9999 ] 

6  Press the [Enter] key.

 ● You will then be returned to the padding 

character settings screen.

7  Use [  ] or [  ] to select "None."

Padding character

8  Press the [Enter] key.

 ● The display returns to the character input 

display. The sequentially numbered control 

character (N) will be entered after "Pump 

Room."

 ● When printing is executed, "Pump Room 1" 

to "Pump Room 10" will be printed.

m p  R o o mNN

NOTE

• Numbering can be set only once per page.

• If you want to cancel the numbering setting, use the [Back Space] key to delete the control character (N) 

of the numbering.

• If you want to set numbering in descending order, such as "10 to 1," enter "10" for the "Start value" and 

"1" for the "End value."
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• The settings for padding characters are as follows.

Setting Details Print Image

None No padding characters. Pump Room 8 Pump Room 9 Pump Room 10 

Zero
A leading "0" will be entered as a 

padding character.
Pump Room 08 Pump Room 09 Pump Room 10 

Space
A leading space will be entered as a 

padding character.
Pump Room  8 Pump Room  9 Pump Room 10 

• If all the sequential numbers have the same number of digits, or if an alphabetic character is selected 

for the sequential number, the settings screen for padding characters will not be displayed.
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 Underline 6, 9

The numbers 6 and 9 can be underlined to distinguish them from each other. The default setting 

is "Off ."

16 9 629

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Print Settings" and press the [Enter] key.

Settings
Page Sett ings
Pr int  Sett ings
Delete  Al l

3  Use [  ] or [  ] to select " Underline 6, 9" and press the [Enter] key.

Print Settings
Plate Full cut
Underline 6 ,  9
Center Line

4  Use [  ] or [  ] to select "On," and then press the [Enter] key.

 ● When printing, the numbers 6 and 9 will be 

underlined. Off  

On

 Underline 6 and 9

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.

NOTE

• The settings for this function are applied to all pages. You cannot change the settings for each page.
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 Adding a Line between Lines

This function allows you to print a solid line (center line) between the fi rst and second lines of 

data entered in two lines. The default setting is "Off ."

+12V
+24V

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Print Settings" and press the [Enter] key.

Settings
Page Sett ings
Pr int  Sett ings
Delete  Al l

3  Use [  ] or [  ] to select " Center Line," and then press the [Enter] key.

Print Settings
Plate Full cut
Underline 6 , 9 
Center Line

4  Use [  ] or [  ] to select "On," and then press the [Enter] key.

 ● When printing, a solid line will be printed 

between the fi rst and second lines.
Center Line

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.

NOTE

• The settings for this function are applied to all pages. You cannot change the settings for each page.

• The center line will not be printed in the following cases.

 - When the number of lines is "1 Line" or "3 Lines."

 - When the orientation is "Vert/Hor char."
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 Setting the Cut Length

 About Cut Length

The length of one tube (or one label) is called the " Cut Length." The default setting is "Automatic."

A1 Pump Room 

 Cut length

Setting Details Print Image

Automatic

(Default Setting)

Automatically sets and prints the 

optimal cut length based on the 

number of characters entered, 

the size of the characters, and the 

spacing between the characters. 

The alignment is centered, and the 

margins are 2 mm on the left and 2 

mm on the right.

A1 Pump Room 

Specify

Prints with the specifi ed cut length. 

When "Specify" is selected for 

"Cut Length," you can specify the 

alignment (and margin), plate print 

area, and all line centering.

e.g.)  "Left" alignment

A1 Pump Room 

e.g.)  Plate Print Area: "Expansion," All 

line centering: "On"

A-123 
R11
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 Specify the  Cut Length and  Alignment

This is how the cut length and alignment are set. If you set the cut length to "Specify," you can 

change the alignment. The default setting for alignment is set to "Centered."

Setting Details Print Image

Centered 

(Default Setting)
Centers the text.

Pump Room

Margin Margin

Cut Length

Left

Aligns text to the left end (in the 

direction of the start of the text). 

Margins can be set in the range of 

2 to 5 mm.

Margin (2 - 5 mm)

Pump Room

Cut Length

Right

Aligns text to the right end (toward 

the end of the text). Margins can 

be set in the range of 2 to 5 mm.

Margin (2 - 5 mm)

Cut Length

Pump Room

Even Distribution

Places text at equal intervals. 

Margins are 2 mm on the left and 2 

mm on the right.

Margin (2mm) Margin (2mm)

Cut Length

P u m p R o o m

NOTE

• When "Centered" or "Even Distribution" are selected and the maximum number of characters for the 

cut length is used, the minimum margin is 0.7 mm in total for both sides.
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[Example] Creating a tube as follows.

Cut length (40 mm)

Alignment (Left)

Pump Room

Margin (5 mm)

1  Press the [Seg Len] key.

2  Use [  ] or [  ] to select "Cut Length," and press the [Enter] key.

Cut Length
Cut Length
Alignment
Plate Print Area

3  Use [  ] or [  ] to select "Specify," enter "40.0" (Cut Length), and then press 

the [Enter] key.

 ● The value can be set by entering numbers or 

using arrow keys ([  ]/[  ]).

 ● Cut length can be entered in the range of 8 mm 

to 150 mm (4 mm to 150 mm for label/plate 

only) in 0.1 mm increments.

 ● Press the [Enter] key to return to the character 

input display.

Cut Length

40.0mm
    8.0 to 150.0mm

4  Press the [Seg Len] key.

5  Use [  ] or [  ] to select "Alignment" and press the [Enter] key.

Cut Length
Cut Length
Alignment
Plate Print Area
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 6  Use [  ] or [  ] to select "Left" and enter "5" (margin).

 ● The value can be set by entering numbers or 

using arrow keys ([  ]/[  ]).
Alignment

Centered
Left    : 5㎜ [2 to 5]
Right : 5㎜ [2 to 5]

7  Press the [Enter] key.

 ● The display returns to the character input 

display. Input the characters.

 ● Cut length and alignment can be checked 

on the display.

NOTE

• The cut length and alignment can be set for each page.

• Depending on the character size, some cut lengths cannot be specifi ed.

• If you want to change the cut length of all pages, use "Batch Setting." (P.63) In Batch Setting, the 

"Cut Length," "Alignment," "Plate Print Area," and "All line centering" settings are applied to all pages.

• Approximately 60 mm from the print start position, there may be a slight diff erence between the 

specifi ed cut length and the print result.

• Depending on your print media and environment, the cut length and margins may diff er from the 

settings. If the results are not as expected even after setting the cut length and margins, fi ne-tune the 

cut length and print position. For more information on fi ne adjustment of the cut length and print 

position, refer to "Fine Adjustment of Print Position and Cut Length (P.85)".

• When the Plate Print Area is set to "Expansion," the "Left" and "Right" margins cannot be set. (They will 

be set to "0 mm.") (P.58)

• When the print media is a label or a plate, the cut length is "less than 8.0 mm;" when the Plate Print 

Area is "Normal," the alignment is "Centered" and the settings cannot be changed.

• When the orientation is set to "Vert/Hor char," the alignment cannot be set.
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 Expanding the Print Area of the Plate

When the  Plate Print Area is set to "Expansion," the print area can be expanded for printing. The 

default setting is set to "Normal."

Setting Details Print Image

Normal 

(Default Setting)

The margins specifi ed in the 

alignment are set.
(P.55)

Expansion

When "Centered" is selected: The text 

is centered.

A-123 

(Cut length - a)/2(Cut length - a)/2

Cut length

a

When "Left" alignment is selected, 

the text is placed at the left end (in 

the direction of the start of the text). 

The left margin is 0 mm.

A-123 

Cut length

"Right" alignment: Aligns the text at 

the right end of the text (toward the 

end of the text). The margin is 0 mm 

on the right.

A-123 

Cut length

"Even Distribution" alignment: The 

text is spaced evenly. The margin is 0 

mm on the left and right.

A - 1 2 3

Cut length
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[Example] Create a plate as shown below.

4mm

A-12 

1  Press the [Seg Len] key.

2  Press [  ] or [  ] to select "Cut Length," and then press the [Enter] key.

Cut Length
Cut Length
Alignment
Plate Print Area

3  Use [  ] or [  ] to select "Specify," enter "4.0" (Cut Length), and then press 

the [Enter] key.

 ● The value can be set by entering numbers or 

using arrow keys ([  ]/[  ]).

 ● The display returns to the character input 

display.

Cut Length
Automatic
Specify   4.0㎜

[      4.0    to    150.0㎜    ]

4  Press the [Seg Len] key.

5  Use [  ] or [  ] to select "Alignment" and press the [Enter] key.

Cut Length
Cut Length
Alignment
Plate Print Area

6  Use [  ] or [  ] to select "Centered," and press the [Enter] key.

 ● Press the [Enter] key to return to the character 

input display.

 ● "×" will appear next to the alignments that 

cannot be selected.

Alignment
Centered
Left
Right
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7  Press the [Seg Len] key.

8  Use [  ] or [  ] to select the "Plate Print Area" and press the [Enter] key.

Cut Length
Cut Length
Alignment
 Plate Print Area

9  Use [  ] or [  ] to select "Expansion," and press the [Enter] key.

 ● When you press the [Enter] key, a message will 

appear. Press any key to return to the character 

input display.

 ● When "Expansion" is selected, the print media 

is automatically changed to "Plate." You cannot 

select any other print media except plate.

Plate Print Area

When selecting 
expansion of Plate 
Print Area, only 
Plate can be printed.

10 Set the character size to "2 mm half-width."(P.42)

11  Input text.

 ● The Plate Print Area setting can be checked on 

the display.

NOTE

• The Plate Print Area can be set for each page.

• You can change the setting of the Plate Print Area when the cut length is "Specifi ed." When the cut 

length is "Automatic," the Plate Print Area cannot be changed.
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 Align Multiple Lines of Text to the Center

When "Centered" is selected for "Alignment," multiple lines of text are centered and placed in the 

center of the page. The default setting is "Off ."

Setting Details Print Image

Off  

(Default Setting)

Align multi-line text at the 

beginning and center them on the 

page.

A-123 
R11 

On
Multi-line text is centered and 

placed in the center of the page.

A-123 
R11 

[Example] Create the following labels.

A-123 
R11 

1  Set the number of lines to "2 Lines."(P.48)

2  Enter the text.

3  Press the [Seg Len] key.

4  Press [  ] or [  ] to select "Cut Length," and then press the [Enter] key.

Cut Length
Cut Length
Alignment
Plate Print Area
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5  Use [  ] or [  ] to select "Specify," enter "19.0" (Cut Length), and then press 

the [Enter] key.

 ● The value can be set by entering numbers or 

using arrow keys ([  ]/[  ]).

 ● Press the [Enter] key to return to the character 

input display.

Cut Length
Automatic
Specify   19.0㎜

[     15.7    to    150.0㎜   ]

6  Press the [Seg Len] key.

7  Use [  ] or [  ] to select " All centering."

Cut Length
Alignment
Plate Print Area
All centeri

8  Use [  ] or [  ] to select "On," and then press the [Enter] key.

 ● Press the [Enter] key to return to the character 

input display.
All line centering

NOTE

• The All line centering can be set for each page.

• You may not select All line centering in the following cases.

 - When the cut length is set to "Automatic."

 - When the alignment is set to anything other than "Centered."

 - When the number of lines is set to "1 Line."

 - The orientation is "Vert/Hor char."
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 Setting the Cut Length Settings for All Pages.

You can set the Cut Length settings (Cut Length, Plate Print Area, Alignment, and All line 

centering) for all pages at once.

1  Press the [Seg Len] key.

2  Use [  ] or [  ] to select " Batch Setting," and press the [Enter] key.

 ● The cut length setting screen will appear. Cut Length
Plate Print Area
All centering
Batch Setting

3  Use [  ] or [  ] to select "Specify," enter the cut length, and then press the 

[Enter] key.

 ● The value can be set by entering numbers or 

using arrow keys ([  ]/[  ]).

 ● When you press the [Enter] key, the Plate Print 

Area setting screen appears.

Cut Length
Automatic
Specify   10.0㎜

[     4.0     to    150.0㎜    ]

4  Use [  ] or [  ] to select the setting and press [Enter] key.

 ● Select "Normal" if you want to print on an area 

other than the plate.

 ● When the Plate Print Area is set to "Expansion," 

the print media is automatically changed to 

"Plate." You cannot select any other print media 

except plate.

 ● Press the [Enter] key, and the alignment setting 

screen will appear.

Plate Print Area
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5  Use [  ] or [  ] to select the desired setting, and then press the [Enter] key.

 ● When you select "Left" or "Right," set the margins. 

(P.57)

 ● When you press the [Enter] key, the All line 

centering setting screen appears.

Alignment
Centered
Left     :  2㎜ [2 to 5]
Right  :  2㎜ [2 to 5]

6  Use [  ] or [  ] to select the settings, and then press the [Enter] key.

 ● Press the [Enter] key to return to the character 

input display after the data has been checked 

and changed.

All  line centering

NOTE

• If there is data that exceeds the cut length due to changes in the batch settings, a confi rmation 

message will appear to delete the data that exceeds the cut length. To cancel the operation, select 

"No."

• If you are unable to input text due to batch setting, set the cut length of the page to "Automatic" or 

change the character size.
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 Creating and Editing Pages

 Creating a New Page

To create a new page, press the [Enter] key. (Page Break)

[Example] Create a new page after the currently displayed page.

200V

200V

(Page 1)

(Page 1) (Page 2)

1  Move the cursor to the end of the line.

2  Press the [Enter] key.

● A page break will be performed and a new page 

will be created.

● You can check the page number of the currently 

displayed page on the display. 

Also, arrows (  / ) before and after the page 

number indicate that there is a page before or 

after the currently displayed page.

NOTE

• The format setting of the new page will be the same as the previous page. For more information 

about format setting, refer to "About Format Settings (P.41)".
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Copying a Page

You can copy the page where you have entered text and paste it before or after another page.

[Example] Copy the fi rst page and paste it after the second page.

200V C1

200V

200V

Pump
Room

C1

Copy and past

(Page 1) (Page 2) (Page 3)

(Page 1) (Page 2)

(Page 3)

(Page 4)

Pump
Room

1  Display the page to be copied (the fi rst page).

2  Press the [Edit] key.

3  Use [  ] or [  ] to select "Copy," and press the [Enter] key.

● A confi rmation screen will appear. Page Edit
Insert
Delete
Copy     

4  Use [   ] or [   ] to select "Yes" and press the [Enter] key.

● The fi rst page will be copied and you will be 

returned to the character input display.
Copy data of page
       1?

  Yes             No
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5  Press the [Edit] key.

6  Use [  ] or [  ] to select "Paste" and press the [Enter] key.

 ● A confi rmation screen for the paste location 

will appear.
Page Edit

Copy  
Cut
Paste

7  Use [   ] or [   ] to enter "2" (page), and use [  ] or [  ] to select "After."

Paste data where?

Before 
After

 page  2

8  Press the [Enter] key.

 ● The copied page will be pasted to the 

specifi ed location and you will be returned 

to the character input display.
  Pasting data...
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 Moving Pages

Cut the page on which you have entered text and paste it before or after another page.

[Example] Cut the second page and paste it after the third page.

200V

200V

C1

C1

(Page 1) (Page 2) (Page 3)

(Page 1) (Page 2) (Page 3)

Pump
Room

Pump
Room

Pump
Room

Cut and past

1  Display the page to be moved (page 2).

2  Press the [Edit] key.

3  Use [  ] or [  ] to select "Cut," and press the [Enter] key.

● A confi rmation screen will appear. Page Edit
Delete
Copy
Cut
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4  Use [   ] or [   ] to select "Yes" and press the [Enter] key.

 ● The second page will be cut and you will be 

returned to the character input display.
Cut data of page
       2?

  Yes             No

5  Press the [Edit] key.

6  Use [  ] or [  ] to select " Paste" and press the [Enter] key.

 ● A confi rmation screen for the paste location 

will appear.
Page Edit

Copy  
Cut
Paste

7  Use [   ] or [   ] to enter "2" (page), and use [  ] or [  ] to select "After."

Paste data where?

Before 
After

 page  2
 

8  Press the [Enter] key.

 ● The cut page will be pasted to the specifi ed 

location and The display returns to the 

character input display.
  Pasting data...
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 Inserting a Page

Inserts a blank page at the specifi ed location.

[Example] Insert a new blank page between the fi rst and second pages.

200V

200V C1

C1

(Page 1) (Page 2) (Page 3)

(Page 1) (Page 2) (Page 3) (Page 4)

Pump
Room

Pump
Room

1  Display the page at the position where you want to insert a blank page (page 

2).

2  Press the [Edit] key.

3  Use [  ] or [  ] to select "Insert," and then press the [Enter] key.

● A confi rmation screen will appear. Page Edit
Insert
Delete
Copy

4  Select "Yes" with [   ] or [   ] and press the [Enter] key.

● A blank page will be inserted on the second 

page, and you will be returned to the 

character input display.
  Yes             No

Insert at  page          2 ?
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 Delete a Page

Deletes a specifi ed page. When you delete a page, the data entered on that page will also be 

deleted.

[Example] Deleting the second page.

200V

200V C1

C1

Pump
Room

Pump
Room

(Page 1) (Page 2) (Page 3)

(Page 1) (Page 2)

1  Display the page you want to delete (page 2).

2  Press the [Edit] key.

3  Use [  ] or [  ] to select "Delete," and press the [Enter] key.

● A confi rmation screen will appear. Page Edit
Insert
Delete
Copy

4  Use [   ] or [   ] to select "Yes" and press the [Enter] key.

● The second page will be deleted and you 

will be returned to the character input 

display.
  Yes             No

Delete   page          2 ?
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 Page Division

You can divide the data which is entered two lines in one page into two pages.

[Example] Page division of page 3.

1  Display the page to be divided (page 3).

2  Press the [Edit] key.

3  Use [  ] or [  ] to select " Division," and press the [Enter] key.

Page Edit
Cut
Paste
Division

4  Use [  ] or [  ] to select "Specify," and press the [Enter] key.

 ● If you select "All," all pages will be divided. Page division

All
Specify
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5  Use [   ] or [   ] to enter "1" (for page) and press the [Enter] key.

 ● The second line of the third page will be 

created as the fourth page, and you will be 

returned to the character input display.

How many pages do
you divide from the
current page?
 Page count:       1

  Dividing pages...

NOTE

• If you divide a page of one-line input, the same data will be created for two pages.

[Example] Divide data that contains a page of one-line input with "All".

• You cannot divide a page with three-line input.

• Pages with numbering cannot be divided.

• When you divide a page, the settings such as character size and cut length will be changed. It is 

recommended to save the fi le before dividing it.

 - The following settings will be changed to their default settings. (P.41) 

Character Size / Frame / Cut Length / Orientation / Continuous Print / Character Space

 - Since the character size will be the default setting, the cut length may change depending on the 

data. Also, if the cut length exceeds 150 mm, the data for the excess length will be deleted.
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 Page Combining

You can combine two pages of data into two lines on one page.

[Example] Combine pages 3 to 6.

1  Display the page you wish to make into a combined one (page 3).

2  Press the [Edit] key.

3  Use [  ] or [  ] to select " Combining" and press the [Enter] key.

 ● The page combining selection screen will 

appear.
Page Edit

Paste
Division
Combining

4  Use [  ] or [  ] to select "Specify," and press the [Enter] key.

 ● If you select "All," all pages will be combined 

into one page with two lines.
Page combining

All
Specify



75

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g

5  Use [   ] or [   ] to enter "4" (page) and press the [Enter] key.

 ● Pages 3 to 6 will be combined and you will 

be returned to the character input display.
How many pages do
you combine from the
current page?
 Page count:       4

  Combining pages...

NOTE

• Pages with numbering or pages with two- or three-line input cannot be combined.

• When you combine pages, the settings such as character size and cut length will be changed. It is 

recommended to save the fi le before combining.

 - The following settings will be changed to their default settings. (P.41) 

Character Size / Frame / Cut Length / Orientation / Continuous Print / Character Space

 - Since the character size will be the default setting, the cut length may change depending on the 

data. Also, if the cut length exceeds 150 mm, the data for the excess length will be deleted.
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 Basic Printing Operations

 Printing

After you have fi nished entering and editing text, you can  print.

[Example] Print two tubes as shown below (using ø4.0 mm tubes).

A1 Pump Room 

1  Display the data to be printed, and press the [Print] key.

2  Use [  ] to select "Set to print" and enter [2].

 ● Use the numeric keys or the arrow keys ([   ]/

[   ]) to enter the data. If you make a mistake, 

press the [Back Space] key to delete the entry.

 ● You can specify the number of prints from 1 to 

10.

 ● This operation will print 2 pages of data twice.

" Printing preference display”

Pr int      Preview
Sets  to  pr int :  2
 Tube

Range: Al l
3. 0

3  Select "Tube ø3.0mm" with [  ] and press [   ], [   ] or the [Enter] key.

Pr int      Preview
Sets  to  pr int :  2
 Tube

Range: Al l
3. 0

4  Select "Tube" with [  ] or [  ] and press the [Enter] key.

 ● The following print media can be selected with 

this product. 

Tube / Shrink tube / Label / Clear tube / Wrap 

Around / Plate / Flat tube

Select Media Type

  

Tube
Shrink tube
Label
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5  Use [  ] or [  ] to select "ø4.0mm," and then press the [Enter] key.

 ● You will then be returned to the printing 

preference display.
Tube s ize

3. 0
2. 5

IMPORTANT

• In the following cases, the printer will not be able to detect that the tube has run out during printing, 

and may print on the transport roller. Make sure that the tube is long enough not to be lost during 

printing before starting printing.

 - When the tube size is ø1.5 mm

 - When the print media is set to "Clear Tube."

NOTE

• For setting a tube of a size that is not on the selection list, refer to "Tube Size Selection 

(Recommended) (P.80)".

6  Use the arrow keys ([  ][  ][  ][  ]) to select "Preview," and press the [Enter] 

key.

 ● Check the print preview.

 ● For more information on the print preview, refer to 

"Checking the Print Preview (P.81)".

Pr int      Preview
Sets  to  pr int :  2
 Tube

Range: Al l
4. 0

NOTE

• No error message will be displayed even if the print data extends beyond the width (top and bottom) 

of the print media. It is recommended to refer to the preview to make sure that no characters are 

missing before printing.

7  Use [  ] to select "Print" and press the [Enter] key.

 ● Printing will be started. Pr int      Preview
Sets  to  pr int :  2
 Tube

Range: Al l
4. 0
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8  Removing the tube.

 ● When printing is fi nished, the tube will be 

automatically cut (Full cut). Also, a cut (Half cut) 

can be made between the tubes.

IMPORTANT

• After printing, remove the print media from the printer to prevent warping or deformation of the print 

media.

• Do not place any objects around the outlet of this product. If there is an object blocking the outlet, 

the tube or label tape may not be ejected straight and may be cut in a bent shape.

• Do not pull the tube or label tape forcibly during printing. Doing so may result in printing failure or 

malfunction.

NOTE

• To cancel printing, press the [Canc] key. The printer will stop printing and cut the print media, then 

stop. If you press and hold the key for two seconds or more, the printer will stop without cutting.

• The plate will not be half cut. If you set the number of prints when printing a plate, a cut line (dotted 

line) will be printed for each sheet printed.

• In the default setting, "Plate Full cut" is set to "No," so if you print a plate, it will not be cut after printing. 

Use scissors to cut it. For more information about the "Plate Full cut" setting, refer to "Changing the 

Plate Full Cut (P.95)".



80

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g
• When setting the tube, refer to the following for the print settings.

 Tube Size Selection (Recommended)

Print Media Print Setting

Type Size (mm) Size selection

Tube

Clear tube

Shrink tube

ø1.5 to ø2.0 1.5mm

ø2.1 to ø2.5 2.5mm

ø2.6 to ø3.5 3mm

ø3.6 to ø4.5 4mm

ø4.6 to ø5.5 5mm

ø5.6 to ø6.2 6mm

ø6.3 to ø6.7 6.5mm

ø6.8 to ø7.5 7mm

ø7.6 to ø8.5 8mm

ø8.6 to ø9.5 9mm

ø9.6 to ø10 10mm

Flat tube ø1.5 to ø2.0 1.5mm

ø2.1 to ø2.5 2.5mm

ø2.6 to ø3.5 3mm

ø3.6 to ø4.5 4mm

ø4.6 to ø5.5 5mm

ø5.6 to ø6.2 6mm

ø6.3 to ø6.5 6.5mm
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 Checking the  Print Preview

Before printing, you can check the print preview on the display.

1  Display the data to be printed, and press the [Print] key.

2  Use [   ] to select Preview, and then press the [Enter] key.

 ● The print preview will be displayed, fl owing from 

right to left.
Pr int      Preview
Sets  to  pr int :  1
 Tube

Range: Al l
3. 0

200V    Pump

•  While pressing [  ] or [  ], the display will 

stop.

•  If you hold down [   ], the image will be 

displayed in fast forward.

•  Press [   ] to display the next page.

•  Press [Canc] key to cancel preview display.

 ● When the preview display fi nishes, you will 

return to the printing preference display.

NOTE

• When you specify the following print media, the line 

indicating the width of the print media is not shown in the 

preview.

 - Tube (ø7 mm to ø10 mm), shrink tube (ø7 mm to ø10 

mm), clear tube (ø7 mm to ø10 mm)

 - Labels (12 mm)

200V    Pump

• The preview may not exactly match the actual print result.
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 Printing by Specifying a Print Range

You can specify a specifi c page or range to print. The default setting for the print range is set to 

"All pages."

Setting Details

All pages 

(Default Setting)
Prints all pages.

Cursor page Prints only the currently displayed page.

Specifi ed page Prints the range specifi ed by "Start page" and "End page."

[Example]  Print pages 2 to 4 of the following data.

Pump Room C1 C2 

200V

(Page 1)

Pump
Room

(Page 2)

C1

(Page 3)

C2

(Page 4)

C3

(Page 5)

1  Display the data to be printed, and press the [Print] key.

2  Use [  ] or [  ] to select "Range", and use [   ] or [   ] to select "Specifi ed."

Print       /Preview
Range :   
Start page 
End page :   1

:   1
Specified
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3  Use [  ] or [  ] to select "Start page" and enter [2].

 ● Use the numeric keys or the arrow keys 

([   ]/[   ]) to enter the data.
Print       /Preview
Range :   
Start page 
End page

:   2
Specified

:   2

4  Use [  ] or [  ] to select "End page" and enter [4].

 ● Use the numeric keys or the arrow keys 

([   ]/[   ]) to enter the data.
Print       /Preview
Range :   
Start page 
End page

:   2
Specified

:   4

5  Use [  ] to select "Print" and print. (P.77)

Pr int      Preview
Sets  to  pr int :  1
 Tube

Range: Specified
3. 0



84

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g

 Setting Up Repeat Printing of a Page

If you want to set up repeat printing for a page, enter the number of times in "Continuous Print." 

For Continuous Print, you can set the number of prints from 2 to 200 per page.

[Example] Print the second page three times.

200V C1 

(Page 2)

200V

(Page 1) (Page 3)

Pump
Room

C1

Pump Room Pump Room Pump Room 

1  Display the page to be printed in Continuous Print.

2  Press the [Cont Print] key.

3  Use [  ] or [  ] to select "Set count" and enter "3" (the number of times for 

Continuous Print).

● Use the numeric keys or the arrow keys 

([   ]/[   ]) to enter the data.

● The value can be set in the range of 2 to 200 

(times).

Continuous Print
Off
Set count
     [  to  200  ]

4  Press the [Enter] key.

● The display returns to the character input 

display.

● The number of times for Continuous Print can 

be checked on the display.

5  Print. (P.77)

NOTE

• Continuous Print is set for each page.

• When you want to cancel the Continuous Print setting (print once), set "Off " in step 3 above.
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 Adjustment of Printing Results

 Fine Adjustment of Print Position and Cut Length

Depending on your print media and the environment, the print position may be shifted or cut 

length may be diff erent from the setting. If you cannot get the result you expected even after 

setting the cut length and margins, fi ne-tune the print position and cut length.

For this product, the following adjustments can be set for each type of print media (for vertical 

adjust, by type and by size).

Function Details

Top adjust Fine-tune the print start position.

Vertical adjust Fine-tune the print position in the vertical direction.

Length adjust Fine-tune the cut length.

IMPORTANT

• If the situation is not improved by adjusting the adjustment function, clean the transport roller. (P.185) 

Also, make sure that there is no dirt on the print media.
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 ■ Fine-tuning of the Print Start Position ( Top Adjust)

[Example]  When printing on a tube in the "Centered" position, the text is shifted to the left, 

so move the print start position 2.0 mm to the right.

ABCDABCD

Move the print start position 
2.0 mm to the right.

1  Press the [Adjust] key.

2  Use [  ] or [  ] to select "Top position" and press the [Enter] key.

Top posit ion  
Vert icalPosit ion
Length

3  Use [  ] or [  ] to select "Tube," and press the [Enter] key.

Top adjust

ShrinkTube
Label

Normal
Normal

Normal

Tube

4  Use [   ] to display "R 2.0 mm" and press the [Enter] key.

 ● Input the adjust value by [  ] (left direction) or [ 

 ] (right direction).

 ● You can adjust the range from Left 2.5 mm to 

Right 2.5 mm in 0.1 mm steps.

A
Top posit ion adjust

Right   2. 0

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input display.

IMPORTANT

• Top adjust is not available for plates.
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 ■   Fine-tuning the Print Position in the Vertical Direction ( Vertical 

Adjust)

[Example]  When printing on a tube (ø6.0 mm), the print position is shifted upward, so move 

the print position downward by 0.5 mm.

ABCDABCD Move the print position 
downward by 0.5 mm.

1  Press the [Adjust] key.

2  Use [  ] or [  ] to select "VerticalPosition," and press the [Enter] key.

Top posit ion  
Vert icalPosit ion
Length

3  Use [  ] or [  ] to select "Tube," and press the [Enter] key.

Vertical adjust

ShrinkTube
Label

Tube

4  Use [  ] or [  ] to select "ø6.0 mm" and press the [Enter] key.

Tube size
5. 0
6. 0
6. 5

Normal
Normal
Normal

5  Use [  ] to display "Down 0.5 mm" and press the [Enter] key.

 ● Use [  ] (upward)/[  ] (downward) to enter 

the adjust value.

 ● You can adjust the range from 1.0 mm upward 

to 1.0 mm downward in 0.1 mm increments.

Vertical adjust

[     Down  0. 5 ]

6  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input display.
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 ■ Fine-tuning the Cut Length ( Length Adjust)

[Example]  When printing on a tube with a cut length of "30 mm," the tube is printed shorter 

than the setting, so the cut length is increased by 2 mm.

ABCD

The cut length is increased by 2mm.

1  Press the [Adjust] key.

2  Use [  ] or [  ] to select "Length," and press the [Enter] key.

Top posit ion  
Vert icalPosit ion
Length

3  Use [  ] or [  ] to select "Tube," and press the [Enter] key.

Length adjust

ShrinkTube
Label

Tube 0. 0
0. 0
0. 0

4  Use [  ] to enter "+2.0mm" and press the [Enter] key.

 ● Use [  ] (negative direction) or [  ] (plus 

direction) to enter the adjust value. You can also 

input using [+]/[-] keys or numeric keys.

 ● You can adjust the range from -7.5 mm to 7.5 

mm in 0.1 mm increments.

Length adjust

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input display.

IMPORTANT

• No further adjust in the negative direction will be applied when there is no more space for adjust (other 

than characters) or when the minimum cut length or less is reached. For the minimum cut length of 
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each print media, refer to "Specifi cations (P.226)".

• If the problem is not corrected by using the length adjust, set the half cut to "None" and cut with 

scissors. For more information about the half cut setting, refer to "Changing the Half Cut Settings 

(P.92)".
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 Changing the Print Density

Depending on the print media you are using and the environment, the printing may be too light 

or too dark. In such cases, adjust the print density. 

The density can be set for each print media. The default setting is "3."

[Example]  Adjust the print density of the tube so that it is the darkest.

1  Press the [Adjust] key.

2  Use [  ] or [  ] to select " Print density," and press the [Enter] key.

Adjustments
Ful l  Cut  Depth
Ful l  Cut  Motion
Pr int  density

3  Use [  ] or [  ] to select "Tube," and press the [Enter] key.

Print density

ShrinkTube
Label

Tube

4  Select "5" with [   ] or [   ] and press the [Enter] key.

 ● A "  " mark will be displayed under the current 

setting.

 ● Density can be set in the range of 1 (lightest) to 

5 (darkest).

1 2 3 4 5

Print density

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input display.
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 Changing the Print Speed

If printing is blurred or uneven, adjust the print speed. 

The default setting is "High."

[Example]  Setting the speed to "Low" because the text is blurred.

1  Press the [Setting] key.

2  Use [  ] or [  ] to select "Setting," and press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3  Use [  ] or [  ] to select " Print Speed," and then press the [Enter] key.

Sett ing
Print speed
Display contrast
Backlight (ADPTR)

4  Use [  ] or [  ] to select "Low," and then press the [Enter] key.

 ● The speed can be adjusted to three levels: "Low," 

"Mid," and "High."
Pr int  speed

Low
Mid
High

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.

 ● The print speed setting can be checked on the 

display.
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 Cutter Settings

 Changing the Set Cut

This product automatically cuts the print media when printing is fi nished. (Full cut) In addition, 

a half cut is made between the tubes and labels after printing, so that you can cut the tubes by 

hand or cleanly peel off  labels from release paper.

Half cut Full cut

A1 Pump Room 

 ■  Changing the  Half Cut Settings

The default setting is "(Half Cut) On."

If you do not want to use a half cut, you can print the cut line (solid/dotted line).

Half cut
Cut line 

settings
Details Print Preview

On 

(Default 

Setting)

-
After printing, cut lines are added 

between tubes and labels.

A1 Pump Room 

Half cut

Off 

Off 

No cut between tubes or labels 

after printing, and no cut line will 

be printed. No cut line

A1 Pump Room 

Line

A solid cut line will be printed 

between tubes and labels after 

printing. Line

A1 Pump Room 

Dotted

A dotted cut line will be printed 

between the printed tubes and 

labels.

A1 Pump Room 

Dotted

NOTE

• When printing on a plate, no half cut is made regardless of the half cut setting. However, the cut line 

will be printed as set.
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[Example]  Printing a cut line (Dotted) without a half cut.

1  Press the [Set Cut] key.

2  Use [  ] or [  ] to select "Half Cut" and press the [Enter] key.

Hal f  cut
Ful l  cut
Plate  Ful l  cut

3  Use [  ] or [  ] to select "Off ," and press the [Enter] key.

Off
On

Half  cut

4  Use [  ] or [  ] to select "Dotted" and press the [Enter] key.

 ● The display returns to the character input 

display.
Cut  L ine

None
Line
Dotted

 ● You can check the half cut setting on the display.
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 ■ Changing the  Full Cut Settings

The default setting is "End only."

Setting Details Print Preview

End only 

(Default 

Setting)

Cuts the print 

media at the end 

of printing.

Full cut

A1 Pump Room A1 Pump Room 

Each set
Cuts match the 

number of prints.

1st group 2nd group

Full cut Full cut

A1 Pump Room A1 Pump Room 

[Example]  Full cut for all pages printed.

1  Press the [Set Cut] key.

2  Use [  ] or [  ] to select "Full cut" and press the [Enter] key.

Set  Cut
Hal f  cut
Ful l  cut
Plate  Ful l  cut

3  Use [  ] or [  ] to select "Each set," and then press the [Enter] key.

 ● The display returns to the character input 

display.
Ful l  Cut

End only
Each set

NOTE

• If you want to use the cutter to cut the plate completely, change the "Plate Full cut."
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 ■  Changing the  Plate Full Cut

The default setting is "Off  (Plate Full cut).

Plate Full cut Details Print Preview

Off  

(Default Setting)
Not cut the end of printing.

Not cut

A1 Pump Room 

On Cuts at the end of printing.

Full cut

A1 Pump Room 

[Example]  When a plate is printed, the end of the printing is cut with a full cut.

1  Press the [Set Cut] key.

2  Use [  ] or [  ] to select "Plate Full cut," and then press the [Enter] key.

Hal f  cut
Ful l  cut
Plate  Ful l  cut

3  Use [  ] or [  ] to select "On," and then press the [Enter] key.

 ● The display returns to the character input 

display. Off
On

Plate  Ful l  cut
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 Adjusting the Cut Depth

If the cutter blade is becoming less sharp or half cutting is too deep, adjust the depth of the cut. 

Adjustment can be set for both "Half cut" and "Full cut."

 ■ Changing the Cut Depth for Half Cut

The cut depth for half cut can be set for each print media. The default setting is set to "Normal."

NOTE

• If cutting is diffi  cult depending on the material of the print media, adjust the motion of the cut. 

(P.100)

[Example]  The half cut of the label tape is too deep (or too shallow), so adjust the half-cut 

depth.

1  Press the [Adjust] key.

2  Use [  ] or [  ] to select " Half Cut Depth," and then press the [Enter] key.

Hal f  Cut  Depth
Half  Cut  Motion
Ful l  Cut  Depth

3  Use [  ] or [  ] to select "Label," and press the [Enter] key.

Label
Clear Tube
WrapAround

Half  Cut  Depth

Normal
Normal

Normal
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4  Use [  ] or [  ] to select the half cut depth adjustment value, and press the 

[Enter] key.

 ● The Half Cut Depth can be set in 11 levels: "Deep 

(1 to 5)," "Normal," and "Shallow (1 to 5).

 ● Each time you press [  ], the cut is deepened 

by one step.

 ● Each time you press [  ], the cut will become 

shallower by one step.

Half  Cut  Depth

[     Deep  1      ]

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.

IMPORTANT

• If you make the cut depth deeper than necessary, the cutter and blade receiver will wear out quickly.

NOTE

• If the half cut is too deep even when the cut depth is adjusted to the shallowest setting, the blade 

receiver may be worn out. Replace the cutter and blade receiver. (P.189)
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 ■ Changing the Cut Depth for Full Cut

The cut depth for the full cut can be set for each print media. The default setting is set to 

"Normal."

[Example]   The full cut of the tube is not cut properly, so make the cut one step deeper.

1  Press the [Adjust] key.

2  Use [  ] or [  ] to select " Full Cut Depth," and press the [Enter] key.

Adjustments
Hal f  Cut  Depth
Half  Cut  Motion
Ful l  Cut  Depth

3  Use [  ] or [  ] to select "Tube," and press the [Enter] key.

Normal
Normal

Normal
ShrinkTube
Label

Tube
Full Cut Depth

4  Use [  ] to select "Deep 1" and press the [Enter] key.

 ● Full Cut Depth can be set in four levels: "Deep 

(1~3)," "Normal."

 ● Each time you press [  ], the cut is deepened 

by one step.

Full Cut Depth

[     Deep  1      ]

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.

IMPORTANT

• If you make the cut depth deeper than necessary, the cutter and blade receiver will wear out quickly.
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 Using Forced Full Cut

If the situation is not improved after adjusting the cut depth for full cut, use "Forced full cut." With 

Forced full cut, the cut is made to the deepest point. If the situation is not improved even after 

using Forced full cut, replace the cutter. (P.189)

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Others" and press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3  Use [  ] or [  ] to select " Forced full cut," and then press the [Enter] key.

 ● A confi rmation screen will appear.

 Remove
 Cleaning
 Forced ful l  cut

4  Select "Yes" with [   ] or [   ] and press the [Enter] key.

 ● Full cut will be performed.

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.
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 Adjusting the Cut Motion

If cutting is diffi  cult depending on the material of the print media, adjust the motion of the cut. 

Adjustment can be set for both "Half cut" and "Full cut."

NOTE

• If the cutter blade is becoming less sharp, adjust the depth of the cut. (P.96)

 ■ Changing the Motion of the Half Cut

The motion of the half cut can be set for each print media. The default setting is set to "Normal."

[Example]   The half cut of the label tape is not cut properly, so the cut is made stronger.

1  Press the [Adjust] key.

2  Use [  ] or [  ] to select " Half Cut Motion" and then press the [Enter] key.

Adjustments
Hal f  Cut  Depth
Half  Cut  Motion
Ful l  Cut  Depth

3  Use [  ] or [  ] to select "Label," and press the [Enter] key.

Tube
ShrinkTube
Label

Hal f  Cut  Motion
Normal

Normal
Normal

4  Use [  ] to select "Intense" and press the [Enter] key.

 ● You can set the Half Cut Motion in two levels, 

"Normal" and "Intense."
Half  Cut  Motion

Normal
Intense

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input display.
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 ■ Changing the Cutting Motion of Full Cut

You can set the motion of the full cut for each print media. The default setting is set to "Normal."

[Example]   The tube is not cut properly when using a full cut, so make the cut stronger.

1  Press the [Adjust] key.

2  Use [  ] or [  ] to select " Full Cut Motion," and press the [Enter] key.

Adjustments
Hal f  Cut  Motion
Ful l  Cut  Depth
Ful l  Cut  Motion

3  Use [  ] or [  ] to select "Tube," and press the [Enter] key.

Tube
ShrinkTube
Label

Ful l  Cut  Motion
Normal

Normal
Normal

4  Use [  ] to select "Intense" and press the [Enter] key.

 ● Full Cut Motion can be set in two levels: "Normal" 

and "Intense."
Ful l  Cut  Motion

Normal
Intense

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.
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 Saving and Loading Text Data

 Saving a File

You can save the text data you have created as a "File" in the device. In addition, the product 

comes with 10 pre-made "folders," and each folder can hold up to 99 fi les.

Folder 1 Folder 10

File1 File 99

・・・

(Page 1) (Page 2) (Page 3)

・・・

200V C1
Pump

Room

[Example]  Save the created data in "Folder 1" with the fi le name "A-1."

1  Press the [File] key.

2  Use [  ] or [  ] to select "Save," and press the [Enter] key.

File
Save
Load
Delete

3  Select "Folder 1" and press the [Enter] key.

Select  Folder
Folder  1
Folder  2
Folder  3
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4  Enter "A-1" (fi le name), and then press the [Enter] key.

 ● You can enter up to 8 characters for the fi le 

name.
A－1

Input file name

5  Select "Yes" with [   ] or [   ] and press [Enter] key.

 ● The "Saving..." message will be displayed, and 

then the display returns to the character input 

display. Yes                No

Save as
A－1                              ?

IMPORTANT

• Do not turn off  the power while the fi le is being saved. If the power is turned off  while saving a fi le, the 

data may be destroyed.

NOTE

• For more information on character input, refer to "Basic Input Operations (P.36)".

• For the number of characters that can be saved in the printer, refer to "Specifi cations (P.226)".

• If you try to save a fi le with the same name as a fi le that has already been saved, the following message 

will appear. If you want to overwrite the fi le, click [Yes].

already exists.
Overwrite?

XXXXXXXX

Yes                No

• The fi le name of the saved data cannot be changed. If you want to change the fi le name, save it again 

with a new name.
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 Loading a File

There are two types of loading for saved fi les: "New" and "Add." Depending on the selected 

mode, the data will be loaded as follows.

Setting Item Details

New Text only Only the data currently being edited will be erased and 

replaced with the loaded data.

Text+settings The data and format setting currently being edited will be 

erased and replaced with the loaded data and format setting.

Add Text only Adds the loaded data to the last page of the data currently 

being edited. 

The format setting of the last page currently being edited 

will be applied to the loaded data.

Text+settings Adds the loaded data to the last page of the data currently 

being edited. 

The format setting at the time of fi le saving will be applied to 

the Loaded data.

NOTE

• For more information on format setting, refer to "About Format Settings (P.41)".

[Example]  Load the data in the fi le named "A-1" in "Folder 1" and its format setting, and add 

it to the last page of the data currently being edited.

1  Press the [File] key.

2  Use [  ] or [  ] to select " Load" and press the [Enter] key.

File
Save
Load
Delete
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3  Use [  ] or [  ] to select "Add" and press the [Enter] key.

Load
New
Add

4  Use [  ] or [  ] to select "Text+settings" and press the [Enter] key.

Add

   Text+sett ings
   Text  only

5  Use [  ] or [  ] to select "Folder 1" and press the [Enter] key.

Select  Folder
Folder  1
Folder  2
Folder  3

6  Use [  ] or [  ] to select "A-1," and then press the [Enter] key.

 ● An "X" will be displayed next to the name of fi les 

that cannot be "Add" loaded due to the size of 

the data.

Select  F i le
A－1
A－2
A－3

7  Select "Yes" with [   ] or [   ] and press the [Enter] key.

 ● The "Loading..." message will be displayed, and 

then the display returns to the character input 

display.

 ● The last page of the loaded data will be 

displayed.

Add
 A－1
text+settings?

Yes           No

NOTE

• When a fi le with text exceeding the cut length is inserted into data with a specifi ed cut length, if you 

load it as "text only," the characters past the cut length will be deleted, then the text will be displayed.
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 Deleting a File

This is how to delete a saved fi le.

Select one of the following options for fi le deletion.

One fi le:

 Deletes only one fi le in the folder.

Folder contents:

 Deletes all the fi les in the folder.

All fi les:

 Deletes all fi les in all folders.

[Example]  Delete the fi le named "A-1" in "Folder 1."

1  Press the [File] key.

2  Use [  ] or [  ] to select " Delete," and press the [Enter] key.

File
Save
Load
Delete

3  Use [  ] or [  ] to select "One fi le," and then press the [Enter] key.

 ● Select "One fi le," "Folder contents," or "All fi les." Delete
One file
Folder  contents
Al l  fi les

4  Use [  ] or [  ] to select "Folder 1," and then press the [Enter] key.

Select  Folder
Folder  1
Folder  2
Folder  3
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5  Use [  ] or [  ] to select "A-1" and press the [Enter] key.

Select  F i le
A－1
A－2
A－3

6  Select "Yes" with [   ] or [   ] and press the [Enter] key.

 ● The "Deleting..." message will be displayed, and 

then the display returns to the character input 

display. Yes                No

Delete
A－1                              ?
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  Changing the Folder Name

This is how to change the name of a folder. 

The product comes with 10 folders ("Folder 1" to "Folder 10").

[Example]  Rename "Folder 1" to "Pump."

1  Press the [File] key.

2  Use [  ] or [  ] to select "Save," and press the [Enter] key.

File
Save
Load
Delete

3  Use [  ] or [  ] to select "Folder 1" and press the Space key.

Select  Folder
Folder  1
Folder  2
Folder  3

4  Press the [Del] key to delete all characters in "Folder 1."

Folder  1

Input folder name

5  Enter "Pump" (folder name), and then press the [Enter] key.

 ● You can enter up to eight characters for the 

folder name.
Pump

Input file name
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6  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.

NOTE

• For more information on character input, refer to "Basic Input Operations (P.36)".

• To return the changed folder name to the original fi le name ("Folder 1" to "Folder 10"), press the [Del] 

key in step 4 above to erase all characters, and then press the [Enter] key.
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  Installing the Software

The "MK Desktop Utility" application software specially designed for this product allows you to 

input and edit text on your computer.

 Install the  MK Desktop Utility and Printer driver

Install the "MK Desktop Utility" application software and the printer driver.

This section explains how to install the "MK Desktop Utility" application software and the printer 

driver at the same time.

IMPORTANT

• For more information on the MK Desktop Utility operating environment and printer driver, refer to 

"System Requirements for Software (P.228)".

• Log on as a user with administrative privileges.

• Close any virus detection programs or programs that run in the background on the system beforehand.

• If the printer and computer are connected with a USB cable, unplug the connected USB cable.

1  Download the software on the computer.

 ● Connect to the internet from a computer and 

access the following Canon website.

-  Users in the U.S.A

https://www.usa.canon.com/internet/

portal/us/home/support/

-  Users in the South & Southeast Asia

https://asia.canon/en/support/download

2  Open the decompressed fi le, double click “setup.exe”.

 ● The installation program starts.

 ● If [User Account Control] dialog box appears, 

click [Yes].

https://www.usa.canon.com/internet/portal/us/home/support/
https://www.usa.canon.com/internet/portal/us/home/support/
https://asia.canon/en/support/download
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3  Select the model, and then click [OK].

4  Select the installation type, and then click [Installation].

 ● When installing either the MK Desktop Utility or 

the printer driver, select "Custom."

 ● When you click [Installation], the screen for 

starting the installation of the MK Desktop Utility 

will appear.

5  Click [Next].

6  Read the license agreement carefully, select [I accept the terms of the license 

agreement], and then click [Next].

 ● The license agreement for the MK Desktop Utility 

is displayed.
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7  Select the destination folder.

 ● If you want to install the software in the 

displayed folder, click [Next].

 ● If you want to change the destination folder, 

click [Change] and specify the folder to be 

installed.

8  Click [Install].

 ● The installation of "MK Desktop Utility" will start.

9  Click [Finish].

 ● The installation of "MK Desktop Utility" is 

completed.

 ● When you click [Finish], the printer driver 

installation start screen appears.
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10 Click [Next].

11 Read the license agreement carefully, and then select [I accept the terms of 

the license agreement] and click [Next].

 ● The license agreement for the printer driver is 

displayed.

12 Click [Install].

NOTE

• If the Windows Security screen appears, check the box for 

"Always trust software from CANON FINETECH NISCA INC." 

and click [Install].
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13  Click [OK].

14  Select [Yes, I want to restart my computer now.] and click [Finish].

 15  After restarting the computer, connect the printer to the computer with the 

USB cable.

16 Turn on the printer. (P.15)

17 Press the [Connect] key.
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18 Select "PC connect" and press the [Enter] key

 ● The message "Waiting for data..." is displayed, 

and the printer is ready to print from a computer.
Connect

PC connect
Bluetooth
DistributedPrint

PC Connect

Wait ing for  data . . .

 19 Open the printer folder and confi rm that the printer icon is displayed.

 ● For Windows 11:

Select [Start] > [All apps] > [Windows Tools] 

> [Control Panel] > [Hardware and Sound] > 

[Devices and Printers].

 ● For Windows 10:

Select [Start] > [Windows System Tools] > 

[Control Panel] > [Hardware and Sound] > 

[Devices and Printers].

 ● For Windows 8.1:

Right-click [Start] > [Control Panel] > [View 

Devices and Printers].

The installation of the "MK Desktop Utility" application software and the printer driver is 

complete.
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 Connecting Multiple MK5000 Printers

If you want to connect multiple MK5000 printers to a single computer, you will need to install 

the printer driver for each unit. After installing the printer driver for the fi rst printer, follow the 

steps below to add printer drivers.

IMPORTANT

• If the printer and computer are connected with a USB cable, unplug the connected USB cable.

• Up to three MK5000 printers can be connected.

• If there are multiple printers connected via USB, the print data can be evenly divided and printed. 

(Distributed Print) (P.158)

1  Turn on the printer. (P.15)

2  Press the [Connect] key.

3  Select "Distributed Print" and press the [Enter] key.

Connect
PC connect
Bluetooth
DistributedPrint

4  Select the printer ID, and press the [Enter] key.

 ● Select "MK5000-001," "MK5000-002," or "MK5000-

003."

 ● Do not duplicate the printer IDs set for each 

printer.

 ● Press the [Enter] key to return to the character 

input display.

Distributed print
MK5000 - 001
MK5000 - 002
MK5000 - 003
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5  Press the [Connect] key.

6  Select "PC connect" and press the [Enter] key.

 ● The message "Please connect USB cable." is 

displayed.
Connect

PC connect
Bluetooth
DistributedPrint

PC Connect

Please connect  USB 
cable .

7  Connect the printer to the PC with the USB cable.

 8  Open the printer folder and confi rm that the icon for "Canon MK5000 (Copy 

1)" (or "Canon MK5000 (Copy 2)") is displayed.

 ● For Windows 11:

Select [Start] > [All apps] > [Windows Tools] 

> [Control Panel] > [Hardware and Sound] > 

[Devices and Printers].

 ● For Windows 10:

Select [Start] > [Windows System Tools] > 

[Control Panel] > [Hardware and Sound] > 

[Devices and Printers].

 ● For Windows 8.1:

Right-click [Start] > [Control Panel] > [View 

Devices and Printers].

This completes the process of adding another printer driver.
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 Uninstalling the MK Desktop Utility and Printer Driver

This will  uninstall the "MK Desktop Utility" application software and the printer driver.

This section explains how to uninstall the "MK Desktop Utility" application software and the 

printer driver at the same time.

1  Disconnect the USB cable.

 ● After confi rming that no printing is in progress, turn off  the printer and then 

disconnect the interface cable.

2  Click [Start] > [Windows System Tools] > [Control Panel] > [Programs and 

Features].

 ● For Windows 11

Click [Start] > [All apps] > [Windows Tools] > [Control Panel] > [Programs and 

Features].

 ● For Windows 8.1

From the desktop charm, click [Settings] > [Control Panel] > [Programs and Features].

3  Select "MK Desktop Utility" from the list and click [Uninstall].

 ● A confi rmation message will appear.

NOTE

• User Account Control may be displayed. If it appears, click [Yes].

4  Select [Remove], and then click [Next].

 ● A confi rmation message will appear.
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5  Click [Yes].

6  Click [Finish].

 ● The uninstallation of "MK Desktop Utility" is 

completed.

7  Select "Canon MK5000 Printer Driver" from the list, and then click [Uninstall].

 ● A confi rmation message will appear.

NOTE

• User Account Control may be displayed. If it appears, click [Yes].

8  Select [Delete], and then click [Next].

 ● A confi rmation message will appear.

9  Click [Yes].
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10 Select "Yes, I want to restart my computer now." and click [Finish].

 ● The uninstallation of the printer driver is 

completed.

The uninstallation of the "MK Desktop Utility" application software and the printer 

driver is complete.
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 Connecting to a Computer

To print from your computer, switch the product into the  PC connection mode.

1  Connect the printer to the PC with the USB cable.

2  Turn on the printer. (P.15)

3  Press the [Connect] key.

4  Select " PC connect" and press the [Enter] key.

 ● The message "Waiting for data..." is displayed, 

and the printer is ready to print from a 

computer.

Connect
PC connect
Bluetooth
DistributedPrint

PC Connect

Wait ing for  data . . .

NOTE

• When you operate the printer from the keyboard, the PC connection state is canceled. Make sure that 

"Receiving" is not shown on the printer's display, and then press the [Canc] key.

• You can change the function of the [Connect] key when it is pressed. If you assign a frequently used 

connection to the [Connect] key, you can easily switch between connection statuses. (P.202)
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 Starting Up/Exiting the Program

 Start up the MK Desktop Utility

1  Double-click the [MK Desktop Utility] shortcut icon  on the desktop.

 ● Once launched, the main screen will be 

displayed.

 ● You can also start the program in the following 

way.

For Windows 11: 

Start menu > [All apps] > [MK Desktop Utility] > 

[MK Desktop Utility]

For Windows 10: 

Start menu > [MK Desktop Utility] > [MK Desktop 

Utility]

For Windows 8.1: 

1)  Move the mouse pointer on the Start screen 

and click the down arrow displayed at the 

bottom of the screen.

2)  Select [MK Desktop Utility] from the All Apps 

screen (Apps View).

IMPORTANT

• If the message "Printer Utility DLL not found" is displayed, 

the printer driver installation has not been completed. 

Follow steps 15 through 19 in "Installing the Software 

(P.115)."

• If the same error occurs again, reinstall the printer driver. 

(P.111).
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 Exit the MK Desktop Utility

1  Click the  (Close) button in the upper right corner of the main window.

 ● Alternatively, click [Exit] on the [File] menu.
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 Screen Confi guration

 Main Screen

The main screen of the MK Desktop Utility is organized as follows.

3

4

5

6

7

1 2

1     Menu bar For more information, refer to "Menu Bar (P.126)".

2     Toolbar For more information, refer to "Toolbar (P.129)".

There is a Data Toolbar, a Send Toolbar and an Edit Toolbar.

3     Format Setting Area Displays the formatting information for the selected page.

For more information about format setting, refer to 

"Confi gure the Format Setting (P.138)".

4     Data List Displays the list of data being edited.

5     Preview Area Displays the image of the printed result.

6     Status Bar Displays information about the current status.

7     Print Media Selection 

Area

Sets the type and size of the print media.
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 Menu Bar

The menu bar displays the functions of the MK Desktop Utility. Click on a menu to display a 

drop-down list of submenus.

 ■ [File] menu

New Creates a new data list. (P.130)

Open Open an existing fi le or CSV fi le to load data. (P.131)

Add Open another fi le and add it to the data currently being edited. 

(P.135)

Save Overwrite and save the data currently being edited.(P.136)

Save As Save the data currently being edited in a separate fi le which you will 

specify the name of. (P.136)

Compound Page Print 

Settings

Prints multiple pages on one tube (or one label). (P.151)

Select printer Select the printer to be used.

Send data, and Save 

fi le

Save the data currently being edited to a folder in the printer.  (P.166)

Print Print the data currently being edited. (P.144)

Printer data backup Saves the backup data of fi les stored in the printer to the computer, 

and writes the backup data to the printer. (P.173)

Exit Exits the MK Desktop Utility. (P.124)

 ■ [Edit] menu

Undo Invalidates the previous operation.

Redo Re-enables the operation that was invalidated by "Undo."

Cut Cuts the specifi ed content and pastes it to the clipboard.

Copy Copies the specifi ed content to the clipboard.

Paste Pastes the contents of the clipboard.
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Delete Deletes the specifi ed portion.

Numbering Automatically create pages by assigning consecutive numbers or 

letters to a fi xed string of characters. (P.142)

Send page selection Add or remove check marks from multiple pages at once.

Page Cut Cut the specifi ed page and paste it to the clipboard.

Page Copy Copy the contents of the specifi ed page to the clipboard.

Page Paste Pastes the contents of the clipboard to the front of the specifi ed page.

Page Insert Inserts a blank page before the cursor page.

Page Delete Deletes the cursor page.

Format Setting [Page Setting]

Allows you to change the format setting of the cursor page. (P.138) 

[Default Setting]

Set the format to be used when creating a new data list or inserting a 

page.

 ■ [View] menu

Data Toolbar Shows or hides the data toolbar. 

Send Toolbar Switches between showing and hiding the send toolbar.

Edit Toolbar Switches between showing and hiding the edit toolbar.

Status Bar Switches between showing and hiding the status bar.

Preview Switches between showing and hiding the preview area.
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 ■ [Remote] menu

Print data in the Printer Prints the data held in the printer’s character input display. (P.164)

Save fi le Save the data held in the printer’s character input display to a folder in 

the printer. (P.171)

 ■ [Help] menu

Help Displays the help menu.

About Displays the version information.
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 Toolbar

The toolbar displays frequently used menus as buttons.

Data Toolbar

(New) Creates a new data list. (P.130)

(Open)
Open an existing fi le or CSV fi le to load data. (P.131)

(Save) Overwrite and save the data currently being edited. (P.136)

Send Toolbar

(Send data, and Save fi le) Save data to a folder in the printer. (P.166)

(Print) Print the data currently being edited. (P.144)

Edit Toolbar

(Undo) Invalidates the last operation.

(Redo) Re-enables the operation that was invalidated by "Undo."

(Cut) Cuts the specifi ed text.

(Copy) Copies the specifi ed text.

(Paste) Pastes the cut or copied text.

(Delete) Deletes the specifi ed text.

(Numbering)
Automatically create pages by assigning consecutive 

numbering or letters to a fi xed string of characters. (P.142)

(Page Cut) Cuts the specifi ed page.

(Page Copy) Copies the specifi ed page.

(Page Paste)
Pastes the cut or copied page to the front of the specifi ed 

page.

(Page Insert) Inserts a blank page before the cursor page.

(Page Delete) Deletes the cursor page.
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 Working with Files

 Creating a New File

1  Click  (New).

 ● Or, you can select [New] from the [File] menu.

 ● A new fi le will be created.

NOTE

• For more information on entering and editing data, refer to "Input and Edit (P.137)".

• The MK Desktop Utility can only launch one window at a time.

• The format setting for new fi les and additional pages will be based on the values set in the [Format 

Setting] - [Default Setting] section of the [Edit] menu. For more information about format setting, refer 

to "Confi gure the Format Setting (P.138)".



131

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g

 Opening a File

The fi le formats that can be opened with MK Desktop Utility are as follows.

•  MK Desktop Utility File (*.md5)

  For more information, refer to "Opening a File Created with this Software (P.131)".

•  Conventional Application File (*.md4; *.md3; *.md2; *.MTD)

  For more information, refer to "Opening a File Created with a Conventional 

Application (P.132)".

•  CSV File (*.CSV)

  For more information, refer to "Opening a CSV fi le (P.133)".

 ■  Opening a File Created with this Software

1  Click  (Open).

 ● Or, select [Open] from the [File] menu.

2  Select a fi le in MK Desktop Utility File (*.md5) and click [Open].

 ● The specifi ed fi le will open and be displayed in 

the data list.
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 ■  Opening a File Created with a Conventional Application

1  Click  (Open).

 ● Or, select [Open] from the [File] menu.

2  Select "Conventional Application File (*.md4; *.md3; *.md2; *.MTD)" for the 

fi le type.

3  Select a fi le in the conventional application fi le (*.md4; *.md3; *.md2; *.MTD) 

and click [Open].

 ● The specifi ed fi le will open and be displayed in 

the data list.

 ● When the fi le is opened, a message will be 

displayed informing you that the fi le has been 

converted to the new format (.md5).

4  Click [OK].

 ● The specifi ed fi le will open and be displayed in 

the data list.

NOTE

• When saving the edited data, save it as an alias using "MK Desktop Utility File (*.md5)" or "CSV File 

(*.CSV)." (P.136)
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 ■  Opening a CSV fi le

When a CSV fi le is opened in the MK Desktop Utility, it will be loaded into the data list under the 

following conditions.

Continuous

Invalid data

Line  1st 2nd 3rd

1st page 
2nd page 
3rd page 

Row 1: Text data of 1st line

Row 2: Text data of 2nd line

Row 3: Text data of 3rd line

Row 4:  Number of continuous 

prints

*  Data in the fi fth and subsequent 

rows is invalid.

NOTE

• The maximum number of lines that can be read is 10000.

1  Click  (Open).

 ● Or, select [Open] from the [File] menu.

2  Select [CSV File (*.CSV)] for the fi le type.
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3  Select a fi le in CSV File (*.CSV) and click [Open].

 ● The specifi ed fi le will open and be displayed in 

the data list.

 ● When you open the fi le, the "Read Format 

Selection" dialog box will appear.

4  Set the format, and then click [OK].

 ● For details on format setting, refer to 

"Confi gure the Format Setting (P.138)".

NOTE

• When "1 Line" is selected for [Lines], the data in the fi rst column of the CSV fi le will be read. The data in 

the second and third columns will not be read.

• When [Character Size] is set to [1.3 mm Norm], [2 mm Norm], or [2 mm Half ], the data in the third row 

can be loaded.

• When saving the edited data, save it as an alias using "MK Desktop Utility File (*.md5)" or "CSV File 

(*.CSV)." (P.136)



135

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g

 Load Additional Data

The contents of the specifi ed fi le can be additionally loaded at the end of the data list being 

edited.

1  Select [Add] from the [File] menu.

2  Select the fi le to be loaded and click [Open].

 ● The data of the specifi ed fi le will be added to 

the end of the data list being edited.
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 Saving a File

 ■ To Overwrite and Save the File You Are Editing

1  Click  (Save).

 ● Or, select [Save] from the [File] menu.

 ● The fi le will be saved.

NOTE

• When saving a new fi le, the [Save As] dialog box will appear. For details on how to set this up, refer to 

"Saving a fi le as a new name (P.136)" below.

 ■  Saving a fi le as a new name

1  Select [Save As] from the [File] menu.

2  Specify [Save in], [File name] and, [Save as type] and then click [Save].

 ● Select "MK Desktop Utility File (*.md5)" or "CSV 

File (*.CSV)."

 ● The default settings for the save location are as 

follows: 

C:/Users/[User Name]/Documents
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 Input and Edit

 Entering Text

Enter text in the data list.

1  Click (or double-click) on the location where you want to enter text.

2  Enter the text and then press the [Enter] key (or click on another position).

NOTE

• You may not be able to enter text depending on the format setting, such as when a set length is 

specifi ed. For more information on format setting, refer to "Confi gure the Format Setting (P.138)".

• If you press  (Delete) to delete the input, the data will be cleared, but the page itself will not be 

deleted. To delete a page, click  (Page Delete).

• The font used in the preview of the MK Desktop Utility is diff erent from the font of the printer, so the 

font style may diff er between the preview and the printed result.
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 Confi gure the  Format Setting

Change the character size, number of lines, and other format setting.

1  Open the fi le. (P.131)

2  Select the print media and media size to specify the set length.

 ● Since the range of set length that can be 

specifi ed varies depending on the print media, 

set the "Print Media" before format setting (Step 

3).

3  Select the page to change the format in the data list.

 ● To select multiple pages, do one of the 

following.

-  When selecting multiple pages in a row: 

Click on the start point to select it, then click 

on the end point while holding down the 

[Shift] key on your keyboard. Release the [Shift] 

key when you are done.

-  To select multiple, non-contiguous pages: 

Hold down the [Ctrl] key on your keyboard as 

you select pages. When you are done, release 

the [Ctrl] key.

-  You can select all pages by clicking on the 

header line.



139

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g

4  Click  (Setting).

 ● Or, from the [Edit] menu, select [Format 

Setting], then [Page Setting].

 ● Format setting can also be selected from the 

menu that appears by right-clicking on the 

data list.

5  Set each item.

[Orientation]

 ● The orientation (Vert/Hor) and text direction (Vert char/Hor char) are specifi ed in the 

"Orientation" settings. The default setting is "Hor/Hor char."

 ● "Vert/Hor char" is only enabled when no text is entered.

 ● For print image, refer to "Specifying the Orientation and Character Direction 

(P.45)".

[Frame]

 ● This allows you to surround text with a frame. There are 5 frame shapes available, with 

the default setting of "None."

[Set Length]

 ● You can specify the length of one tube (or one label). The default setting is 

"Automatic."

 ● When "Specify" is selected, the length can be entered in the range of 

8 mm to 150 mm (4 mm to 150 mm for labels and plates only) in 0.1 mm increments.
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[Plate printing area]

 ● If you want to print the plate with the margin set to "0 mm," set the plate printing area 

to "Expansion." The default setting is "Normal."

 ● When "Expansion" is selected, the print media is automatically changed to "Plate." You 

cannot select any other print media except plate.

 ● For print image, refer to "Expanding the Print Area of the Plate (P.58)".

[Alignment]

 ● If you set the set length to "Specify," you can change the alignment. The default 

setting for alignment is set to "Centered."

 ● When the plate printing area is set to "Expansion," the "Left-justifi ed" and "Right-

justifi ed" margins cannot be set. (They will be set to "0 mm.")

 ● For print image, refer to "Specify the Cut Length and Alignment (P.55)".

[All line centering]

 ● Centers multiple lines of text on the page. The default setting is "Off ."

 ● For print image, refer to "Align Multiple Lines of Text to the Center (P.61)".

[Character Size]

 ● Sets the character size. The default setting is "3 mm Norm."

[Character Space]

 ● Sets the space between characters. The default setting is "Narrow."

[Lines]

 ● Sets the number of lines. The default setting is "1 Line."

[Continuous]

 ● If you want to set up repeat printing for a page, enter the number of times. The value 

can be set in the range of 1 to 200 (times).

NOTE

• When the set length is specifi ed, the settings for character size, frame, and character space may not be 

able to be changed.

• When the print media is a label or a plate, if the set length is "less than 8.0 mm" and the plate printing 

area is "Normal," "Rule confi guration" (Centered) is applied and the setting cannot be changed.

• If the alignment is set to "Even distribution," the even distribution setting will take priority even if the 

character space is set.

• If you set the orientation to "Vert/Hor char," the settings will be as follows.

 - The character space is set to "Narrow" and cannot be changed.

 - The text will be printed centered even if the alignment is set to "Even distribution."
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 - Regardless of "All line centering" setting, all lines will be centered and printed.

 - The center line will not be printed regardless of the center line setting.

• You may not select "All line centering" in the following cases.

 - When the set length is set to "Automatic."

 - When the text alignment is set to anything other than "Centered."

 - When the number of lines is set to "1 Line."

 - When the orientation is set to "Vert/Hor char" (with "All line centering" set to "On").

• When the compound page print settings is turned on, the following settings cannot be changed.

 -  Orientation, Frame, Set Length, Plate printing area, Alignment, All line centering, Continuous 

(continuous print)

6  Click [OK].

 ● When you click [OK], the format setting are 

confi rmed, and the settings are refl ected in the 

data list (Full/Half-width) and the preview area.

NOTE

• The settings for [Continuous] (continuous print) are not refl ected in the display of the preview area.
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  Numbering

Automatically create pages by assigning consecutive numbering or letters to a fi xed string of 

characters. The possible numbering settings are as follows.

Setting Set range

Decimal 0 to 9999

Hexadecimal 0 to FFFF

Upper case letter A to Z

Lower case letter a to z

[Example] Create a page for "Pump Room 1" to "Pump Room 10"

1  Enter "Pump Room."

 ● Move the cursor to the position where you 

want to enter the numbering.

 ● If a cell is set while selected, the number will 

be entered at the end of the text.

2  Click  (Numbering).

 ● Or, select [Numbering] from the [Edit] menu.

NOTE

• If not even a single character can be entered when the set 

length is specifi ed, a message will be displayed. Change the 

format setting. (P.138)
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3  Set each item.

 ● In this section, we will use the following 

settings.

Mode: Decimal

Start value: 1

End value: 10

Padding Character: None

NOTE

• If you want to set numbering in descending order, such as "10 to 1," enter "10" for the "Start value" and 

"1" for the "End value."

• The settings for padding characters are as follows.

Setting Details

None No padding characters.

Zero A leading "0" will be entered as a padding character.

Space A leading space will be entered as a padding character.

• If all the digits of the numbering are the same, or if an alphabetic character is selected for the 

numbering, "Padding Character" will be grayed out and cannot be set.

• When the set length is specifi ed, the input of the start and end values may be restricted. If the value 

you want to enter cannot be set, change the format setting. (P.138)

4  Click [OK].

 ● A page with a number entered at the end of 

the text is automatically created.

NOTE

•  If you want to cancel the operation immediately after numbering, click  (Undo).
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 Print

  Printing

After entering text and creating a data list, start printing.

1  Connect the printer to the PC with a USB cable, and switch the printer to PC 

connection mode. (P.122)

 ● Confi rm that "Waiting for data..." appears on 

the printer's display.
PC Connect

Wait ing for  data . . .

2  Click [Select printer] on the [File] menu.

IMPORTANT

• If the message is displayed, the printer driver installation 

has not been completed. Follow steps 15 through 19 in 

"Installing the Software (P.115)."

• If the same error occurs again, reinstall the printer driver. 

(P.111).

 3  Select the printer to be used for printing from the [Select printer] drop-down 

list.

 ● The drop-down list will show a list of printer 

drivers installed in your environment.
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4  If you are printing data stored on your computer, open the fi le. (P.131)

5  Select the print media and media size.

 ● When you change the print media and media 

size, the settings will be refl ected in the 

preview area display.

NOTE
• Except for labels/plates, the minimum set length is 8 mm. If 

there are pages of 8 mm or less in the data list and the print 

media is changed to one other than label/plate, a message 

to change the set length to 8 mm will be displayed.

• When the plate printing area is set to "Expansion," the print media cannot be changed. In this case, 

change the plate printing area to [Normal]. (P.138)

• If the print area is exceeded, the message "Exceeding the print area" will be displayed in the preview 

area. Change the print media or change the format setting. (P.138)

• If you want to set a tube that is not on the list of media sizes, refer to "Tube Size Selection 

(Recommended) (P.80)".
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6  Place a check mark in the [Send] box of the page you want to print.

 ● To add or remove check marks from multiple 

pages at once, make the settings from [Send 

page selection] in the [Edit] menu. To select 

pages, do one of the following.

-  When selecting multiple pages in a row: 

Click on the start point to select it, then click 

on the end point while holding down [Shift] 

on your keyboard. When you are done, release 

[Shift].

-  To select multiple, non-contiguous pages: 

Hold down [Ctrl] on the keyboard while 

selecting pages. Release [Ctrl] when you are 

done.

-  You can select all pages by clicking on the 

header line.

 ● You can also select [Send page selection] from 

the menu that appears when you right-click on 

the data list.

7  Click  (Print).

 ● Or, select [Print] from the [File] menu.

IMPORTANT

• If the message is displayed, the printer to use is not 

selected. Select the printer from [Select printer] on the [File] 

menu. (P.144)
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8  Specify the number of tubes (or labels) to be printed.

 ● Specify the number of tubes (or labels) to be 

printed in the range of 1 to 10.

9  Specify the transfer mode.

 ● Select either [Overwrite internal memory] or 

[Add to internal memory] as the transfer mode. 

The data just sent to the printer will be retained 

on the printer’s character input display even 

after printing (or saving) is completed.

 ● Select [Sending without compressing 

numbering data] if you have created numbered 

pages.
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[Overwrite internal memory]

 Select this option when you want to print the 

page you selected in step 6.

[Example]

200V

ABC
(Page 1)

ABC

0001

200V
(Page 1)

0001

200V

Print

200V

[Add to internal memory]

Select this option when you want to add the 

data you entered in step 6 to the data stored in 

the printer and print it. The additional data will 

be added after the last page of the data in the 

printer.

[Example]

ABC
(Page 1)

ABC

0001

ABC
(Page 1)

0002

200V

200V
(Page 2)

ABC

0001

Print

200V

200V



149

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g

[Sending without compressing numbering data]

-  Without a check mark

The numbering part is converted to the 

control character of the numbering (N) and 

sent to the printer as a single page of data.

[Example]

0001

Pump Room

NPump Room      
 (Page 1)

-  With a check mark

Send all pages to the printer.

[Example]

Pump Room 1 to Pump Room 100
(Page 1 to Page 100)

Pump Room 100 

0100

Pump Room 1 

0001

10 If you want to save the print data to a folder in the printer at the same time as 

printing, specify the saving method.

 ● Check "Save transmitted data," and specify [File 

name] and [Folder No.].

 ● You can enter up to 8 characters for the fi le 

name.
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11 Click [OK].

 ● After the data is created on the printer's 

character input display as per the transfer 

mode used, printing will begin. Also, the data 

on the character input display will be retained 

after printing is completed.

NOTE

• If the message "Unable to open printer." appears, confi rm 

the following.

 - The printer is turned on and the computer is connected 

to the printer with a USB cable.

 - The printer is selected correctly. (P.144)

• If the message "Could not receive data from printer." 

appears, the printer has not switched to the PC connection 

mode. Switch the printer to PC connection mode. (P.144)

• If you try to save a fi le with the same name as a fi le that has 

already been saved, the following message will appear on 

the printer display. If you want to overwrite the fi le, click [Yes].

already exists.
Overwrite?

XXXXXXXX

Yes                No

• The font used in the preview of the MK Desktop Utility is diff erent from the font of the printer, so the 

font style may diff er between the preview and the printed result.
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  Compound Page Printing

Prints multiple page data on one tube (or one label).

1  Connect the printer to the PC with a USB cable, and switch the printer to PC 

connection mode. (P.122)

 ● Confi rm that "Waiting for data..." appears on 

the printer's display.
PC Connect

Wait ing for  data . . .

2  Click [Select printer] on the [File] menu.

IMPORTANT

• If the message is displayed, the printer driver installation 

has not been completed. Follow steps 15 through 19 in 

"Installing the Software (P.115)."

• If the same error occurs again, reinstall the printer driver. 

(P.111).

 3  Select the printer to be used for printing from the [Select printer] drop-down 

list.

 ● The drop-down list will show a list of printer 

drivers installed in your environment.
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4  If you are printing data stored on your computer, open the fi le.(P.131)

5  Select the print media and media size.

 ● When you change the print media and media 

size, the settings will be refl ected in the 

preview area display.

NOTE
• Except for labels/plates, the minimum set length is 8 mm. If 

there are pages of 8 mm or less in the data list and the print 

media is changed to one other than label/plate, a message 

to change the set length to 8 mm will be displayed.

• When the plate printing area is set to "Expansion," the print media cannot be changed. In this case, 

change the plate printing area to [Normal].(P.138)

• If the print area is exceeded, the message "Exceeding the print area" will be displayed in the preview 

area. Change the print media or change the format setting.(P.138)
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6  Place a check mark in the [Send] box of the page for which you want to print 

a compound page.

 ● To add or remove check marks from multiple 

pages at once, make the settings from [Send 

page selection] in the [Edit] menu. To select 

pages, do one of the following.

-  When selecting multiple pages in a row: 

Click on the start point to select it, then click 

on the end point while holding down [Shift] 

on your keyboard. When you are done, release 

[Shift].

-  To select multiple, non-contiguous pages: 

Hold down [Ctrl] on the keyboard while 

selecting pages. Release [Ctrl] when you are 

done.

-  You can select all pages by clicking on the 

header line.

 ● You can also select [Send page selection] from 

the menu that appears when you right-click on 

the data list.

7  Select [Compound Page Print Settings] from the [File] menu.
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8  Select the check mark for "Print a compound page" and set the format.

[Orientation]

 ● The orientation (Vert/Hor) and text direction (Vert char/Hor char) are specifi ed in the 

"Orientation" settings. The default setting is "Hor/Hor char."

 ● For print image, refer to "Specifying the Orientation and Character Direction 

(P.45)".

[Frame]

 ● You can surround the entire compound page with a frame. There are 5 frame shapes 

available, with the default setting of "None."

[Set Length]

 ● Allows you to specify the length of the compound page. The default setting is 

"Automatic."

 ● When "Specify" is selected, the length can be entered in the range of 

8 mm to 150 mm (4 mm to 150 mm for labels and plates only) in 0.1 mm increments.

[Plate printing area]

 ● If you want to print the plate with the margin set to "0 mm," set the plate printing area 

to "Expansion." The default setting is "Normal."

 ● When "Expansion" is selected, the print media is automatically changed to "Plate." You 

cannot select any other print media except plate.

 ● For print image, refer to "Expanding the Print Area of the Plate (P.58)".
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[Alignment]

 ● If you set the set length to "Specify," you can change the alignment of text on the 

compound page. The default setting for alignment is set to "Centered."

 ● When the plate printing area is set to "Expansion," the "Left-justifi ed" and "Right-

justifi ed" margins cannot be set. (They will be set to "0 mm.")

 ● For print image, refer to "Specify the Cut Length and Alignment (P.55)".

[All line centering]

 ● Centers multiple lines of text on the page. The default setting is "Off ."

 ● For print image, refer to "Align Multiple Lines of Text to the Center (P.61)".

[Between pages]

 ● Specify the distance between pages in the range of 2.0 to 10.0 mm. The default 

setting is 2.0 mm.

[Font]

 ● Specify the font to be used for compound page printing. The default setting is "Arial."

 ● The font installed in your environment can be selected.

NOTE

• When the print media is a label or a plate, if the set length is "less than 8.0 mm" and the plate printing 

area is "Normal," "Rule confi guration" (Centered) is applied and the setting cannot be changed.

• If the alignment is set to "Even distribution," the even distribution setting will take priority even if the 

character space is set.

• If you set the orientation to "Vert/Hor char," the settings will be as follows.

 - The character space is set to "Narrow" and cannot be changed.

 - The text will be printed centered even if the alignment is set to "Even distribution."

 - Regardless of the "All line centering" setting, all lines will be centered and printed.

 - The center line will not be printed regardless of the center line setting.

• You may not select "All line centering" in the following cases.

 - When the set length is set to "Automatic."

 - When the text alignment is set to anything other than "Centered."

 - When the number of lines is set to "1 Line."

 - When orientation is set to "Vert/Hor char" (and "All line centering" is set to "On").
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9  Click [OK].

 ● When you click [OK], the settings are refl ected 

in the preview area of the display.

10 Click  (Print).

 ● Or, select [Print] from the [File] menu.

IMPORTANT

• If the message is displayed, the printer to use is not 

selected. Select the printer from [Select printer] on the [File] 

menu. (P.151)
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11  Specify the number of tubes (or labels) to print, and click [OK].

 ● Specify the number of tubes (or labels) to be 

printed in the range of 1 to 10.

 ● When you click [OK], printing of the compound 

page will start.

NOTE

• The transfer mode and saving cannot be set.

• If the message "Unable to open printer." appears, confi rm 

the following.

 - The printer is turned on and the computer is connected 

to the printer with a USB cable.

 - The printer is selected correctly. (P.151)

• If the message "Could not receive data from printer." 

appears, the printer has not switched to the PC connection 

mode. Switch the printer to PC connection mode. (P.151)
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 Printing Using Multiple Printers ( Distributed Print)

With distributed print, when there are multiple printers connected via USB, the print data can be 

divided evenly and printed out in a shorter time than when printing on a single printer.

Distributed print can be performed when the following conditions are met.

• When the Compound Page Print settings are disabled. (P.151)

•  When two or more printers are online.

• When the data list is more than 40 pages.

[Example] Printing 100 pages of data on three printers with distributed print.

(Pages 68-100)(Pages 35-67)(Pages 1-34)

1  Connect the printer to the PC with a USB cable, and switch the printer to PC 

connection mode. (P.122)

 ● Confi rm that "Waiting for data..." appears on 

the printer's display.
PC Connect

Wait ing for  data . . .

2  Click [Select printer] on the [File] menu.

IMPORTANT

• If the message is displayed, the printer driver installation 

has not been completed. Follow steps 15 through 19 in 

"Installing the Software (P.115)."

• If the same error occurs again, reinstall the printer driver. 

(P.111).
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 3  Select "Multiple printers" from the [Select printer] drop-down list, and place a 

check mark next to the printers to be used for printing.

4  If you are printing data stored on your computer, open the fi le. (P.131)

5  Select the print media and media size.

 ● When you change the print media and media 

size, the settings will be refl ected in the 

preview area display.

NOTE

• Except for labels/plates, the minimum set length is 8 mm. 

When you change the print media for data of 8 mm or less 

to one other than Label/Plate, the message to change the 

set length to 8 mm will be displayed.

• When the plate printing area is set to "Expansion," the print media cannot be changed. In this case, 

change the plate printing area to [Normal]. (P.138)

• If the print area is exceeded, the message "Exceeding the print area" will be displayed in the preview 

area. Change the format setting. (P.138)
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6  Place a check mark in the [Send] box of the page you want to print.

 ● To add or remove check marks from multiple 

pages at once, make the settings from [Send 

page selection] in the [Edit] menu. To select 

pages, do one of the following.

-  When selecting multiple pages in a row: 

Click on the start point to select it, then click 

on the end point while holding down [Shift] 

on your keyboard. When you are done, release 

[Shift].

-  To select multiple, non-contiguous pages: 

Hold down [Ctrl] on the keyboard while 

selecting pages. Release [Ctrl] when you are 

done.

-  You can select all pages by clicking on the 

header line.

 ● You can also select [Send page selection] from 

the menu that appears when you right-click on 

the data list.
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7  Click  (Print).

 ● Or, select [Print] from the [File] menu.

NOTE
• If the number of printed pages is less than 40, distributed 

print is not possible. Print such data with one printer. 

When this screen is displayed, select a printer and click [OK].

• If there is a printer that is offl  ine, a message about the printers to be used for printing will be displayed.

 - When there is only one printer online:

Print with one printer.

 - If two of the three printers used for printing are online:

Distributed print will be performed on two of the 

printers.
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8  Specify the method of page division.

[Automatic distribution]

 ● The print data is divided into pages evenly and 

printed.

[Specify individually]

 ● Manually specify the page range of the print 

data and print it.

 ● Select the printer to be used for printing from 

the drop-down list and specify the page range 

for each printer.

 ● The page range can also be specifi ed by 

moving the slider. If you have two printers, 

one slider will be displayed; if you have three 

printers, two sliders will be displayed.

 ● If you want to reset the page range 

specifi cation, click [Automatic distribution] 

once.
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9  Specify the number of tubes (or labels) to be printed, and click [OK].

 ● Specify the number of tubes (or labels) to be 

printed in the range of 1 to 10.

 ● Click [OK] to start distributed printing.

NOTE

• If an error occurs in distributed printing, a message will be 

displayed. Check the status of the printer and deal with 

the error. 

If there are any pages that could not be printed due to the 

error, click [Yes]. The page list of the printer where the error 

occurred (the [Distributed Print Recovery] dialog box) will 

be displayed. Select the pages you want to reprint and 

click [OK] to reprint them on the printer that is online.
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 Printing the Data Held in the Printer

The data sent to the printer will be retained in the character input display. This section describes 

the procedure for printing the data retained in the character input display, such as when 

reprinting the previously printed data.

1  Connect the printer to the PC with a USB cable, and switch the printer to PC 

connection mode. (P.122)

 ● Confi rm that "Waiting for data..." appears on 

the printer's display.
PC Connect

Wait ing for  data . . .

2  Click [Select printer] on the [File] menu.

IMPORTANT

• If the message is displayed, the printer driver installation 

has not been completed. Follow steps 15 through 19 in 

"Installing the Software (P.115)."

• If the same error occurs again, reinstall the printer driver. 

(P.111).

 3  Select the printer to be used for printing from the [Select printer] drop-down 

list.

 ● The drop-down list will show a list of printer 

drivers installed in your environment.
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4  Click [Print data in the Printer] on the [Remote] menu.

IMPORTANT

• If the message is displayed, the printer to use is not 

selected. Select the printer from [Select printer] on the [File] 

menu. (P.164)

5  Specify the print media, media size, and the number of tubes (or labels) to 

print, and then click [OK].

 ● The data stored on the character input display 

will be printed.

NOTE

• If you want to check the data stored in the character input display, release the PC connection status. 

Make sure that "Receiving" is not shown on the printer's display, and then press the [Canc] key.

• Except for labels/plates, the minimum set length is 8 mm. If there is a page that is less than 8 mm 

long and the print media is changed to other than label/plate, the set length is changed to 8 mm and 

printed.

• If the message "Unable to open printer." appears, confi rm 

the following.

 - The printer is turned on and the computer is connected 

to the printer with a USB cable.

 - The printer is selected correctly. (P.164)

• If the message "Could not receive data from printer." 

appears, the printer has not switched to the PC connection 

mode. Switch the printer to PC connection mode. (P.164)
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 Save to Internal Memory

 Save the Data to a Folder in the Printer

The data created by the MK Desktop Utility can be saved to a folder in the printer.

NOTE

• For the procedure to save the print data to a folder in the printer at the same time as printing, refer to 

"Printing (P.144)".

• For the procedure to save the print data to your computer, refer to "Saving a File (P.136)".

1  Connect the printer to the PC with a USB cable, and switch the printer to PC 

connection mode. (P.122)

 ● Confi rm that "Waiting for data..." appears on 

the printer's display.
PC Connect

Wait ing for  data . . .

2  Click [Select printer] on the [File] menu.

IMPORTANT

• If the message is displayed, the printer driver installation 

has not been completed. Follow steps 15 through 19 in 

"Installing the Software (P.115)."

• If the same error occurs again, reinstall the printer driver. 

(P.111).

 3  Select the printer to save the data from the [Select printer] drop-down list.

 ● The drop-down list will show a list of printer 

drivers installed in your environment.
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4  If you want to save data stored on your computer in the printer, open the fi le. 

(P.131)

5  Place a check mark in box next to [Send] of the page you want to save.

 ● To add or remove check marks from multiple 

pages at once, make the settings from [Send 

page selection] in the [Edit] menu. To select 

pages, do one of the following.

-  When selecting multiple pages in a row: 

Click on the start point to select it, then click 

on the end point while holding down the 

[Shift] key on your keyboard. Release the [Shift] 

key when you are done.

-  To select multiple, non-contiguous pages: 

Hold down the [Ctrl] key on your keyboard as 

you select pages. When you are done, release 

the [Ctrl] key.

-  You can select all pages by clicking on the 

header line.

 ● You can also select [Send page selection] from 

the menu that appears when you right-click on 

the data list.

6  Click  (Send data, and Save fi le).

 ● Or, select [Send data, and Save fi le] from the 

[File] menu.

IMPORTANT

• If the message is displayed, the printer to use is not 

selected. Select the printer from [Select printer] on the [File] 

menu. (P.166)
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7  Specify the transfer mode.

 ● Select either [Overwrite internal memory] or 

[Add to internal memory] as the transfer mode. 

The data just sent to the printer will be retained 

on the printer’s character input display even 

after printing (or saving) is completed. 

 ● Select [Sending without compressing 

numbering data] if you have created numbered 

pages.

[Overwrite internal memory]

 Select this option when you want to save the 

page you selected in step 5.

[Example]

200V

ABC
(Page 1)

ABC

0001

200V
(Page 1)

0001

200V

Save

200V
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[Add to internal memory]

Select this option when you want to add the 

data you selected in step 5 to the data stored 

in the printer and save it. The additional data 

will be added after the last page of the data in 

the printer.

[Example]

ABC
(Page 1)

ABC

ABC
(Page 1)

0002

200V

200V
(Page 2)

ABC

0001

Save

200V

200V

[Sending without compressing numbering data]

-   Without a check mark

The numbering part is converted to the 

control character of the numbering (N) and 

sent to the printer as a single page of data.

[Example]

0001

Pump Room

NPump Room      
 (Page 1)

-   With a check mark

Send all pages to the printer.

[Example]

Pump Room 1 to Pump Room 100
(Page 1 to Page 100)

Pump Room 100 

0100

Pump Room 1 

0001
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8  Specify the saving method.

 ● Check "Save transmitted data," and specify [File 

name] and [Folder No.].

 ● You can enter up to 8 characters for the fi le 

name.

9  Click [OK].

 ● After the data is created on the printer's 

character input display according to the 

transfer mode, the data will be saved in the 

specifi ed folder in the printer. The data on the 

character input display will be retained even 

after the saving is completed.

NOTE
• If the message "Unable to open printer." appears, confi rm 

the following.

 - The printer is turned on and the computer is connected 

to the printer with a USB cable.

 - The printer is selected correctly. (P.166)

• If the message "Could not receive data from printer." 

appears, the printer has not switched to the PC connection 

mode. Switch the printer to PC connection mode. (P.166)

• If you try to save a fi le with the same name as a fi le that has 

already been saved, the following message will appear on 

the printer display. If you want to overwrite the fi le, click [Yes].

already exists.
Overwrite?

XXXXXXXX

Yes                No
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 Saving the Data Held in the Printer

The data sent to the printer will be retained in the character input display. This section describes 

the procedure for saving the data retained in the character input display, such as when saving 

the previously printed data.

NOTE

• For the procedure to save the print data to a folder in the printer at the same time as printing, refer to 

"Printing (P.144)".

 1  Connect the printer to the PC with a USB cable, and switch the printer to PC 

connection mode. (P.122)

 ● Confi rm that "Waiting for data..." appears on 

the printer's display.
PC Connect

Wait ing for  data . . .

 2  Click [Select printer] on the [File] menu.

IMPORTANT

• If the message is displayed, the printer driver installation 

has not been completed. Follow steps 15 through 19 in 

"Installing the Software (P.115)."

• If the same error occurs again, reinstall the printer driver. 

(P.111).

 3  Select the printer to save the data from the [Select printer] drop-down list.

 ● The drop-down list will show a list of printer 

drivers installed in your environment.
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4  Click [Save fi le] on the [Remote] menu.

IMPORTANT

• If the message is displayed, the printer to use is not 

selected. Select the printer from [Select printer] on the [File] 

menu. (P.171)

5  Specify [File name] and [Folder No.], and then click [OK].

 ● The data held in the character input display will 

be saved to the specifi ed folder in the printer.

NOTE

• If the message "Unable to open printer." appears, confi rm 

the following.

 - The printer is turned on and the computer is connected 

to the printer with a USB cable.

 - The printer is selected correctly. (P.171)

• If the message "Could not receive data from printer." 

appears, the printer has not switched to the PC connection 

mode. Switch the printer to PC connection mode. (P.171)

• If you try to save a fi le with the same name as a fi le that has 

already been saved, the following message will appear on 

the printer display. If you want to overwrite the fi le, click [Yes].

already exists.
Overwrite?

XXXXXXXX

Yes                No
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 Saving Backup Data

 Saving Backup Data to Computer

Saves a backup of the data store in the printer to your computer.

1  Connect the printer to the PC with a USB cable, and switch the printer to PC 

connection mode. (P.122)

 ● Confi rm that "Waiting for data..." appears on 

the printer's display.
PC Connect

Wait ing for  data . . .

 2  Select [Printer data backup] from the [File] menu.

3  Select [Backup from the printer], and then click [OK].
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4  Specify the [Save in] and [File name], and then click [Save].

 ● Click [Save] to start importing the data.

 ● The backup fi le will be saved in the "MK 

Desktop Utility Printer data File (*.mk5)."

 ● The default settings for the save location are as 

follows: 

C:/Users/[User Name]/Documents

IMPORTANT

• Until you see the message "Data backup has been completed," make sure of the following points. 

Otherwise, the data may get corrupted.

 - Do not turn off  the printer or computer.

 - Do not disconnect the USB cable.

 - Do not operate the keyboard.

5  When the completion message is displayed, click [OK].
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 Writing the Backup Data to the Printer

Write the backup data saved on the computer to the printer. Writing backup data overwrites all 

fi les stored in the printer with the backup data.

1  Connect the printer to the PC with a USB cable, and switch the printer to PC 

connection mode. (P.122)

 ● Confi rm that "Waiting for data..." appears on 

the printer's display.
PC Connect

Wait ing for  data . . .

 2  Select [ Printer data backup] from the [File] menu.

3  Select [Recovery to the printer], and then click [OK].

 4  Select a fi le in MK Desktop Utility Printer data File (*.mk5), and click [Open].

 ● When writing backup data created with 

conventional applications, select "Conventional 

Printer data File (*.mk4; *.mk3; *.mdk)" for [File 

of type].
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5  When the overwrite confi rmation message is displayed, click [Yes].

IMPORTANT

• Until you see the message "Then the data recovery has been completed," make sure of the following 

points. Otherwise, the data may get corrupted.

 - Do not turn off  the printer or computer.

 - Do not disconnect the USB cable.

 - Do not operate the keyboard.

6  When the completion message is displayed, click [OK].
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 View the  Status Monitor

The status monitor starts automatically when printing starts and displays the printer status and 

remaining ink ribbon level.

 View Settings for the Status Monitor

Set to show or hide the status monitor. The default setting is "Use the Status Monitor."

1  Select [Start] > [Windows System Tools] > [Control Panel] > [Hardware and 

Sound] > [Devices and Printers].

 ● For Windows 11: 

Select [Start] > [All apps] > [Windows Tools] > [Control Panel] > [Hardware and Sound] 

> [Devices and Printers]. 

 ● For Windows 8.1: 

From the desktop charm, select [Settings] > [Control Panel] > [Hardware and Sound] 

> [Devices and Printers].

2  Right-click the printer icon, and select [Print Settings].

3  Click the [Status Monitor] tab.

4  Select [Use the Status Monitor] or [Not use the Status Monitor], and then click 

[OK].
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IMPORTANT

• When printing from the MK Desktop Utility, do not change the print settings in the Page Setup and 

Graphics sheets. Any changes to the settings will not be refl ected in the printing from the MK Desktop 

Utility.

NOTE

• Click [Version...] to check the printer driver version, copyright, and other information.
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 View  Printer Status

3

1

2

1 Status Displays a message informing you of the current printer status.

2  Ribbon type Displays the type of ribbon cassette. There are three types: "White 85m," 

"Black 150m," and "Black 40m compatible with plate."

3   Ribbon 
remaining

Displays the approximate remaining amount of ink ribbon. (There 

may be a slight diff erence from the actual remaining amount.) If the 

remaining amount is not read correctly, the remaining amount is not 

displayed.

The printer status is displayed in four images.

Indicates that the printer is in a normal state.

Indicates that the printer is online and can print.

Indicates that the printer is offl  ine.

Indicates that a warning has occurred.

A warning message is displayed in the [Status] 

fi eld, but you can continue printing. Take action as 

necessary.

Indicates that an error has occurred. 

An error message is displayed in [Status], and 

printing cannot be performed.
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 List of Message 

If a problem occurs while connected to the printer, an error message or warning message will be 

displayed on the status monitor. Read the message, and follow the corresponding procedure.

 Message Solution

Low ribbon level The ribbon is running low. Prepare a new ribbon cassette.

Low battery level For more information, refer to "Battery is running low. (P.221)".

No Media For more information, refer to "Print media isn’t set. (P.218)".

End of Media For more information, refer to "End of media. (P.219)".

End of Ribbon For more information, refer to "End of ribbon. (P.219)".

Start of Media Not 

Detect

For more information, refer to "Start of media not detect. 

Remove media between print head and cutter. (P.219)".

No ribbon cassette For more information, refer to "Ribbon cassette isn’t set. 

(P.219)".

Media JAM For more information, refer to "Feed error (P.220)".

Cover is Open You cannot print with the cover open. Close the cover and press 

any key.

Check of the size switch 

lever

For more information, refer to "Size switch lever is not 

positioned correctly. Proceed? (P.219)".

Cutter Initialization 

Error

Press any key. If the same message appears again, contact your 

place of purchase.

Head initialization error

Head print position 

error

Warmer temperature 

rise delay error

Turn off  the printer and set the warmer again. (P.31) 

If the same message appears again, contact your place of 

purchase.
Warmer abnormal 

temperature error
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 Cleaning the Printer

 Cleaning the Outside of the Printer

Wipe the surface of the printer periodically to keep it clean.

WARNING
• Before cleaning, be sure to turn off  the power and unplug the power supply. Also, 

remove the batteries from the printer. Doing so may result in fi re or electric shock.

• Do not use alcohol, thinner, or other fl ammable solvents to clean the unit. Doing so 

may result in fi re or electric shock.

1  Turn off  the power and unplug the power plug from the power outlet.

 ● If batteries are being used, remove them.

2  Wipe the surface of the printer.

 ● Wipe the printer with a cloth moistened with water and wrung out tightly. Use a lint-free 

cloth.

 ● Allow the water to dry completely before proceeding to the next step.

3  Insert the power plug into the outlet and turn on the power.



183

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g

 Cleaning the Inside of the Printer

If the inside of the printer is dirty, the print media may become dirty or dust may enter the unit, 

causing printing defects. Wipe it regularly to keep it clean.

WARNING
• Before cleaning, be sure to turn off  the power and unplug the power supply. Also, 

remove the batteries from the printer. Doing so may result in fi re or electric shock.

• Do not use alcohol, thinner, or other fl ammable solvents to clean the unit. Doing so 

may result in fi re or electric shock.

CAUTION
• Remove the cutter before cleaning the area around the cutter and media delivery 

port.

1 Turn off  the power and unplug the power plug from the power outlet.

 ● If batteries are being used, remove them.

2 Open the cover and remove the ribbon cassette, attachment (or label tape 

cassette), and cutter.
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3 Wipe the inside of the printer.

 ● Wipe the printer with a cloth moistened with water and wrung out tightly. Use a lint-

free cloth.

 ● Allow the water to dry completely before proceeding to the next step.

IMPORTANT

• Do not touch the ink ribbon connector, print 

head, or connector for tube warmer inside the 

printer. Doing so may result in malfunction of 

the product.

Connector for 
tube warmer

Print head

Connector for 
ribbon cassette

4  When you have fi nished cleaning, return the cutter to its original position and 

close the cover.
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  Cleaning the Transport Roller

If printing is not clear or the print media cannot be fed properly, the transport roller may be dirty. 

We recommend cleaning the rollers about once a month.

WARNING
• Do not use alcohol, thinner, or other fl ammable solvents to clean the unit. Doing so 

may result in fi re or electric shock.

1 Open the cover and remove the ribbon cassette, and attachment (or label 

tape cassette).

2 Close the cover, and then press the [Settings] key.

3 Use [  ] or [  ] to select "Others" and press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

4 Use [  ] or [  ] to select "Cleaning," and press the [Enter] key.

 ● After pressing a key, instructions will be 

displayed on the screen.

Others

   C leaning
   Remove

   Forced ful l  cut

Cleaning mode

Open safety  cover
and remove dust .
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5 Open the cover.

 ● When the cover is opened, instructions will 

be displayed on the screen.

Cleaning mode

After  c leaning,
c lose safety  cover .

6 Wipe off  any dirt on the transport roller 1, 2 and 3 with a cloth moistened with 

water and wrung out tightly.

 ● Transport roller 3 is cleaned by pushing the 

 jam recovery lever in the direction of the 

arrow.

 ● Use a lint-free cloth.

Jam recovery lever

7 Close the cover.

 ● The transport roller will spin.

8 Repeat steps 5 to 7.

 ● Open and close the cover 8 times to make one rotation of the roller.

9 When cleaning is fi nished, press the [Shift] + [Canc] keys.

 ● The display returns to the character input display.
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  Cleaning the Print Head

If printing is not clear or white streaks appear, the print head may be dirty. We recommend 

cleaning the print head about once a month.

WARNING
• Before cleaning, be sure to turn off  the power and unplug the power supply. Also, 

remove the batteries from the printer. Doing so may result in fi re or electric shock.

• Do not use alcohol, thinner, or other fl ammable solvents to clean the unit. Doing so 

may result in fi re or electric shock.

1 Turn off  the power and unplug the power plug from the power outlet.

 ● If batteries are being used, remove them.

2 Open the cover and remove the ribbon cassette, and attachment (or label 

tape cassette).

3 Wipe off  any dirt on the print head with a cotton swab moistened with water 

and wrung out tightly.

IMPORTANT

• Do not touch the print head directly. Doing so may result in malfunction of the product.

4 When cleaning is fi nished, close the cover.
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  Cleaning/Replacing the Cleaners

The tube attachment, (optional) tube warmer, and (optional) plate and fl at tube attachment are 

equipped with a cleaner (or plate cleaner) to remove dirt from the surface of the print media.

Remove the cleaner (or plate cleaner) as shown in the fi gure, and then remove the dirt from the 

sponge. If the sponge is damaged, replace the entire cleaner.

IMPORTANT

• Dispose the used cleaner and plate cleaner according to local government regulation.

• There are two types of cleaner, the cleaner (blue) and plate cleaner (gray). For more information, refer 

to "Consumable Supplies and Options (P.229)".
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  Replacing the Cutter

If the tube or label tape does not cut properly even after adjusting the depth and motion of the 

cutter, replace the cutter. Also, when replacing the cutter, replace the blade receiver at the same 

time.

CAUTION
• The cutter is designed so that it cannot be touched directly, but if it is handled 

improperly, the blade may pop out and cause injury. Never perform any operation 

that is not described in this manual.

• Do not leave replaced parts unattended. If they come into contact with the hands of 

children, they may cause injury.

• When replacing the cutter, be sure to turn off  the power.

IMPORTANT

• It is best to replace the cutter after about every 50,000 cuts. (When using PVC tube with an inner 

diameter of ø3.2mm)

• Dispose the removed cutter and blade receiver according to local government regulation.

NOTE

• The Mounted Cutter Count is counted regardless of the print media being used. Also, any cutter 

operations performed while printing with the cutter removed will also be counted in the Mounted 

Cutter Count.
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1 Turn off  the power. (P.17)

2 Open the cover.

3 Remove the cutter.

4 Insert the new cutter.

 ● Paying attention to its orientation, insert the 

new cutter until it hits the back of the cutter bay.



191

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g

5 Remove the blade receiver.

6 Insert the new blade receiver.

7 Close the cover.

8 Turn on the power. (P.15)

9 Press the [Settings] key.
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10 Use [  ] or [  ] to select "Others," then press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

11 Use [  ] or [  ] to select "Counter," and then press the [Enter] key.

Others

   Counter

   In i t .  DeleteCheck
   Page Display

12 Record the  Mounted Cutter Count, and then press the [Enter] key.

 ● We recommend that you record the Mounted 

Cutter Count in the "Cutter Operation Record" 

in the Basic Operation Guide included with the 

product each time you change cutters.

Mounted Cutter Count
50000 t imes

10000 m
Total  Feed Length

13 Use [  ] or [  ] to select "Replace cutter" and press the [Enter] key.

 ● After the following screen is displayed, the 

display will return to the previous screen.

 ● The mounted cutter count will be reset to "0".

 ● The depth and motion of the cut will return to 

"Normal".

Others

   Replace cutter

   Forced ful l  cut
   Feed

Cutter  replacement

is  accepted.

14 Press [Shift] + [Canc] keys.

 ● The display returns to the character input 

display.
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 Changing the Printer Settings

 Changing the Auto Power Off  Settings (Adapter/Battery)

Change the amount of time that the unit will automatically turn off  after a certain period of 

inactivity. The auto power off  setting can be set for each power source used, and the default 

setting for both is "30 min."

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Others" and press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3  Use [  ] or [  ] to select " AutoOff  (adapter)" (or " AutoOff  (battery)"), and 

then press the [Enter] key.

Others
Clear tube reverse
AutoOff (adapter)
AutoOff (battery)

4  Use [  ] or [  ] to select the time until the power is automatically turned off , 

and then press the [Enter] key.

 ● You can select the timer setting from "No," "5 

min.," "15 min.," and "30 min." 5 min.
15 min.
30 min.

Auto Off (Adapter)
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5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.

IMPORTANT

• In the following cases, the automatic power off  function will not work.

 - When an error has occurred.

 - When the cover is open.

• The time will be reset when you switch the power source used.

• If the set time elapses without receiving data while connected to a PC or Bluetooth, the power will 

automatically turn off .
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 Changing the Display Settings

You can change the contrast and brightness of the display.

 ■ Adjusting the Display Contrast

The default setting of the display contrast is set to "5."

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Setting," and then press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3  Select " Display contrast" with [  ] or [  ] and press the [Enter] key.

Sett ing
Print speed
Display contrast
Backlight (ADPTR)

4  Select the contrast by [   ] or [   ] and press the [Enter] key.

 ● A" " mark will be displayed under the current 

setting.

 ● Display Contrast can be set in the range of 1 

(lightest) to 9 (darkest).

Display contrast
DarkLight

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.
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 ■  Adjusting the Brightness of the Backlight (Adapter/Battery)

The backlight brightness can be set for each power source used, with the default setting being 

"4" when using the AC adapter and "1" when using batteries.

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Setting," and then press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3  Use [  ] or [  ] to select " Backlight (ADPTR)" (or " Backlight (BAT)") and press 

the [Enter] key.

Sett ing
Display contrast
Backlight (ADPTR)
Backlight (BAT)

4  Select the backlight brightness by [   ] or [   ] and press the [Enter] key.

 ● A" " mark will be displayed under the current 

setting.

 ● The backlight brightness can be set in the range 

of 1 (darkest) to 4 (brightest).

Backlight (Adapter)

1 2 3 4

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.
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 ■ Changing the Automatic Backlight Off  Setting

Change the time for the display backlight to automatically turn off  after a certain period of 

inactivity. The default setting is "5 min."

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Others" and press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3  Use [  ] or [  ] to select " AutoBacklightOff " and press the [Enter] key.

Others
AutoOff (adapter)
AutoOff (battery)
AutoBacklightOff

4  Use [  ] or [  ] to select the time until the backlight turns off  automatically, 

and then press the [Enter] key.

 ● You can select "No," "1 min.," "3 min.," or "5 min." Auto Backlight Off
1 min.
3 min.
5 min.

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.

IMPORTANT

• If the set time elapses without receiving data while connected to a PC or Bluetooth, the backlight will 

automatically turn off .
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 Turning Off  Sounds

Turns off  the key operation sounds and warning sounds. The default setting for the sound is "On."

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Setting," and then press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3  Use [  ] or [  ] to select " Sound," and then press the [Enter] key.

Sett ing
Backlight (ADPTR)
Backlight (BAT)
Sound

4  Use [  ] or [  ] to select "Off " and press the [Enter] key.

Off
On

Sound

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.
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 Speeding Up the Time until Printing Starts

You can speed up the time to start printing by setting not to adjust the print position before 

starting printing. The default setting of the print priority is "Print position."

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Others" and press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3  Use [  ] or [  ] to select " Print priority," and then press the [Enter] key.

Others
AutoBacklightOff
Print priority 
Init. DeleteCheck

4  Use [  ] or [  ] to select "First Print," and press the [Enter] key.

Print priority

 Print position 
 First Print

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.

IMPORTANT

• When "First Print" is selected, the margin at the top portion of the tube is larger than when "Print 

position" is selected. However, if the tube size is "ø1.5 mm," the amount of blank space at the top 

portion will not change even if the print priority setting is changed.
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 Change the Rewind Movement Settings

When printing is fi nished, the top of the print media stops at the cutter position. In this case, 

the print media is sandwiched between the transport roller 2 and the transport roller 3, 

and depending on the material of the print media, the part of the print media sandwiched 

between the transport rollers may be deformed, causing a "Feed error." If the "Feed error" occurs 

repeatedly, try to set the rewind movement to return the top of the print media to the print 

head position after printing. 

The default setting of the rewind movement is set to "Off ."

Cutter 
position

Print head position

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Others" and press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3  Use [  ] or [  ] to select " Rewind movement," and press the [Enter] key.

Replace cutter
Rewind movement 
AutoOff(adapter)

Others
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4  Use [  ] or [  ] to select "On" and press the [Enter] key.

Off
On

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.

IMPORTANT

• When a plate is printed with the Plate Full cut set to "No" (default setting), the top of the plate will stop 

at the cutter position regardless of the rewind movement setting.

• For thin or soft tubes, the tube may not feed properly if you print with the rewind movement set to 

"On." In this case, set the rewind movement back to "Off " (default setting) and print.
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 Changing the Function Assignment of the [Connect] Key

You can  change the function of the [Connect] key when it is pressed. By assigning frequently 

used connections, you can easily switch the connection status. The default setting is "PC or 

Bluetooth."

[Example]  Setting it up so that pressing the [Connect] key enters PC connection mode

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Connect" and press the [Enter] key.

Sett ings
Connect
Warmer
Character  Edit

3  Use [  ] or [  ] to select "ConnectKeyConfi g," and then press the [Enter] key.

Connect

ConnectKeyConfig

Bluetooth
DistributedPrint

4  Use [  ] or [  ] to select "PC connect" and press the [Enter] key.

 ● Select PC or Bluetooth, PC connect, or Bluetooth. Connect  Key Config

PC connect
Bluetooth

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input 

display.
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 Initializing this Printer

Restores all settings to their original settings.  (Initializes the printer)

IMPORTANT

• When initializing, all data being created and fi les stored in the device will be erased. Check your data 

carefully before initializing. Be sure to save any important data to a computer or other device before 

initializing. (P.173)

1  Turn off  the power (P.17)

2  While pressing the [Del All] key, press and hold the power key for at least one 

second.

 ● A confi rmation screen for initialization will 

appear.

3  Select "Yes" with [   ] or [   ] and press the [Enter] key.

 ● After "Resetting..." is displayed, the power will 

turn off .
Reset  a l l  sett ings  ?

Yes                No
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 Bluetooth

You can connect your tablet device to this printer using the Bluetooth function.

NOTE

• For the settings of the tablet device, refer to the instruction manual of the tablet device.

• In order to send data to this printer, you need to install a dedicated application that is compatible with 

this printer on your tablet device. For details, please contact the place of purchase.

 Connecting a Tablet Device to the Printer

1  Press the [Connect] key.

2  Use [  ] or [  ] to select " Bluetooth," and then press the [Enter] key.

Connect
PC connect
Bluetooth
DistributedPrint

Bluetooth

BD Addresss
XX:XX:XX:XX:XX:XX

Standby...

3  Turn on the Bluetooth function of the tablet device and connect it to the 

printer.

 ● When the tablet device is connected to the 

printer, the display will change to "Waiting for 

data..."

Bluetooth

Wait ing for  data . . .
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 If a Tube or Label Tape Becomes 
Jammed

If the print media gets jammed inside the printer, a "Feed error" message will be displayed on the 

display and printing will be canceled. Follow the procedure below to remove the print media.

        Feed error

Media is  jammed in
the feeding path.

NOTE

• If the print media is jammed inside the printer but the message is not displayed, press and hold the 

[Canc] key for 2 seconds or more to stop printing, and then follow the instructions starting from step 2 

to remove the print media. (In this case, the messages shown in the steps below will not be displayed.

1 After reading the " Feed error" message, press any key.

 ● Instructions will be displayed on the screen.
Open the cover .

2 Open the cover.

 ● When the cover is opened, instructions will 

be displayed on the screen.

Remove the ribbon 
cassette.
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3 Remove the ribbon cassette.

 ● If the ribbon is wound around the cassette 

and cannot be removed, do not remove it 

forcibly, and proceed to step 4.

4 Press any key.

 ● After pressing a key, instructions will be 

displayed on the screen.

While pushing the
Jam recovery lever,
remove print media
in the printer.

5 (When using tube or plate)

 As shown in the fi gure, pull the tube (or plate) out while pressing the  jam 

recovery lever in the direction of the arrow.

 ● If the tube (or plate) cannot be pulled out, 

remove the attachment while pressing the 

jam recovery lever in the direction of the 

arrow.

 ● If the ribbon cassette has not been removed 

in the previous step, remove the ribbon 

cassette.

 (When using a label tape)

Remove the cassette while pressing the jam recovery lever in the direction 

of the arrow, as shown in the fi gure.

 ● If the ribbon cassette has not been removed 

in the previous step, remove the ribbon 

cassette.
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6 After removing the print media (or cassette), press any key.

 ● After pressing a key, instructions will be 

displayed on the screen.

Set the ribbon
cassette and close
the cover.

7 Remove any slack in the ribbon.

IMPORTANT

• If the ribbon is loose, it may not operate properly.

8 Replace the ribbon cassette and close the cover.

 ● Insert the ribbon cassette straight in, and 

press fi rmly until it clicks into place.

 ● When the cover is closed, a confi rmation 

screen will be displayed.

9 When the print media has been removed, use [   ] or [   ] to select "Yes" and 

press the [Enter] key.

 ● The display returns to the character input 

display.

 ● If you select "No", a "Feed Error" message will 

be displayed again. Follow the procedure 

from step 1 to completely remove the print 

media.

Yes No
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10 Cut out the bent or damaged portion of the jammed print media or the 

printed portion of the print media if it exists.

 11 Reload the print media. (P.21)

NOTE
• Using the feed function to remove the print media

If the tube or label tape is in a position where it cannot be removed by hand, use the feed function. 

However, if you continue to feed with the feed function, it may damage the print media or the 

ribbon in the ribbon cassette might get rolled up, causing it to jam. Only use this function in 

extenuating circumstances.

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Others," and then press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3  Select " Feed" with [  ] or [  ] and press the [Enter] key.

Others
Forced full cut
Feed
Replace cutter
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4   Use [   ] (Forward) or [   ] (Reverse) to feed the print media to the 

desired position.

 ● As long as you keep pressing [  ] or [ 

 ], it will be fed forward or backward 

continuously.
Forward:

Reverse :

Feed

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character 

input display.
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 What to Do in Case of Trouble

Problem Cause/Things to Check Solution

The power does not turn 

on.

Check that the AC adapter 

and power cord are properly 

connected.

After confi rming that the AC 

adapter and power cord are 

connected, insert the power 

plug fi rmly into the power 

outlet.

Are you using the supplied AC 

adapter (PR-TP001) and power 

cord?

Do not use anything other than 

the supplied AC adapter (PR-

TP001) and power cord. Failure 

to do so may result in fi re, 

electric shock, or malfunction.

Are the batteries installed in 

the wrong direction?

Make sure that all batteries 

are installed correctly in the 

direction marked on the inside 

of the battery case.

 Are the batteries low? Replace the batteries or use the 

included AC adapter (PR-TP001).

Are batteries other than the 

specifi ed ones being used?

Use the specifi ed batteries. 

(P.13)

The display does not 

change to the AC adapter 

symbol even after the AC 

adapter is loaded.

Check that the AC adapter 

and power cord are properly 

connected.

Turn off  the power, make sure 

the AC adapter and power cord 

are connected, and then insert 

the power plug fi rmly into the 

power outlet.

The remaining battery 

charge is not displayed 

correctly.

If you load batteries that 

are not fully charged, the 

remaining battery charge may 

not be displayed correctly.

Use fully charged batteries.

The device does not print 

clearly.

The printing is 

misaligned.

The printing is missing or 

blurred.

Is the type and size of the print 

media selected in the print 

settings the same as the print 

media actually loaded?

Check the loaded print media 

and set the print media type 

and size correctly.

Is the ribbon cassette loaded 

correctly?

Remove the ribbon cassette, 

remove any slack, and then 

reinsert it. (P.19)
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(Continued from previous 

page)

The device does not print 

clearly.

The printing is 

misaligned.

The printing is missing or 

blurred.

Is the attachment or label 

cassette loaded correctly?

Remove the attachment or 

label cassette, and reload it. 

(P.21)

Is the tube or plate twisted or 

warped?

Correct any twists or warps 

before loading. (P.23) 

If the end of the tube or plate 

is bent due to winding or other 

reasons, straighten it out or 

cut off  the bent portion before 

loading it into the printer.

Is the print media deformed? Cut off  the deformed part of 

the print media and reinsert it.

Is the tube or plate dirty? Wipe off  any dirt or dust with a 

dry cloth. Also, do not use tubes 

or plates that have oil or other 

stains that cannot be wiped off .

Is there any load on the tube or 

plate transport?

Place the printer and the print 

media on the same table (or at 

the same vertical position) so 

that no load is applied to the 

transport.

When using a tube reel, lighten 

the load.

No error message will be 

displayed even if the print data 

extends beyond the width of 

the print media.

Refer to "Maximum Printable 

Character Size (P.43)" 

for information on setting the 

character size and frame. It is 

recommended to refer to the 

preview to make sure that no 

characters are missing before 

printing.

Try to fi ne-tune the print 

position in the vertical direction. 

(P.87)

Change the settings for 

character size, frame, and 

number of lines.
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(Continued from previous 

page)

The device does not print 

clearly.

The printing is 

misaligned.

The printing is missing or 

blurred.

Are the print density and print 

speed appropriate?

Adjust the print density to be 

darker. (P.90) Slow down the 

print speed. (P.91)

You may be able to improve 

the problem by changing the 

print priority.

Try setting the print priority to 

"First Print." (P.199)

Are the transport rollers dirty? Clean the transport rollers. We 

recommend cleaning the rollers 

about once a month. (P.185)

Is the print head dirty? Clean the print head.  We 

recommend cleaning the print 

head about once a month. 

(P.187)

Is the cleaner of the 

attachment or (optional) tube 

warmer dirty?

Clean the cleaner. We 

recommend cleaning the 

cleaner about once a month. 

(P.188) 

If the cleaner is worn out, 

replace it with a new cleaner.

Is the inside of the printer dirty? Clean the inside of the printer. 

(P.183)

Is the operating environment 

appropriate?

For information concerning the 

operating environment, refer to 

"Specifi cations (P.226)". 

If you use a tube warmer 

(optional), you can print at 

external temperatures as low as 

5°C (41°F).

If the problem is not solved by 

using the tube warmer.

Set the temperature of the tube 

warmer to "High." (P.34)

The parts of the tube that do 

not pass through the tube 

warmer (such as the top 

portion of the tube) will not be 

warmed up. Check the printout 

on a warmed area.
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Problem Cause/Things to Check Solution

Characters are squashed 

or blurred.

Are you printing small or 

complicated characters?

Adjust the print density. 

(P.90)

The surface of the print 

media is dirty after 

printing.

Ink may stick to the ribbon due 

to the top of the print media 

touching the ribbon during 

printing.

Use a dry cloth to wipe off  any 

dirt on the print media.

Out of ribbon There is a sticky stain on the 

tube that looks like the glue 

from plastic tape.

Use a clean tube.

White vertical lines 

appear when printing on 

the plate.

The print density may not be 

appropriate.

Adjust the print density to 

match the print result. (P.90)

•  If black fi lled symbols ( , 

, etc.) cause streaks (lines), 

reduce the density.

•  If lines appear on characters 

or symbols other than the 

above, increase the density.

I cannot select a print 

media other than "Plate" 

in the print settings.

Some pages are set to 

"Expansion" in the Plate Print 

Area.

Set the Plate Print Area to 

"Normal" or set the Cut Length 

to "Automatic." (P.55)
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Problem Cause/Things to Check Solution

The print media cannot 

be fed properly.

Is there any load on the tube or 

plate transport?

Place the printer and the print 

media on the same table (or at 

the same vertical position) so 

that no load is applied to the 

transport.

When using a tube reel, lighten 

the load.

Are the transport rollers dirty? Clean the transport rollers. 

We recommend cleaning the 

rollers about once a month. 

(P.185)

The tube may not be fed 

properly due to deformation of 

the part that was pinched by 

the transfer roller.

Try setting the rewind 

movement to "On." (P.200) 

Also, cut off  the deformed part 

and reload the print media.

Is there glue on the media 

delivery port of the label tape?

Check to see if glue is sticking 

to the media delivery port of 

the label tape. (P.25)

If glue is adhered to the media 

delivery port of the label tape, 

the label tape may become 

stuck.

Is the operating environment 

appropriate?

For information concerning the 

operating environment, refer 

to "Specifi cations (P.226)". 

If you use a tube warmer 

(optional), you can print at 

external temperatures as low 

as 5˚C (41˚F).

The device cannot make 

full cuts.

The device cannot make 

half cuts.

Half cuts are cut too 

deep.

Are the cutter and blade 

receiver set correctly?

Refer to "Replacing the 

Cutter (P.189)" for 

information on how to set 

the cutter and blade receiver 

correctly. 

Are the depth and motion of 

the cut appropriate?

Please adjust the depth 

(P.96) and motion (P.100) 

of the cutter.

Is it time to replace the cutter? Replace the cutter and blade 

receiver. (P.189)
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Problem Cause/Things to Check Solution

The cutting position is 

off .

The printed area gets cut.

The tube is cut at an 

angle.

Are there any objects around 

the media delivery port that 

prevent the media from being 

ejected?

Do not place any objects around 

the media delivery port. If there 

is an object blocking the outlet, 

the tube or label tape may not 

be ejected straight and may be 

cut in a bent shape.

Is there any load on the tube or 

plate transport?

Place the printer and the print 

media on the same table (or at 

the same vertical position) so 

that no load is applied to the 

transport.

When using a tube reel, lighten 

the load.

Is the tube twisted or warped? Correct any twists or warps 

before loading. (P.23) 

If the end of the tube is bent 

due to winding or other 

reasons, straighten it out or 

cut off  the bent portion before 

loading it into the printer.

Depending on your print 

media and environment, the 

print position may be shifted or 

the length of one tube (or one 

label) may be diff erent from 

the setting.

Make fi ne adjustments to the 

print position and cut length. 

(P.85) 

If the problem is not corrected 

by using the length adjust, set 

the half cut to "Off " and cut 

with scissors.
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 A Message is Coming Up

If a problem occurs during operation of or printing using product, an error message will be 

displayed on the display. Read the message, and follow the corresponding procedure.

 Message Details/Solution

Input value is out of the 

acceptable range.

Enter a value within the setting range.

In Vert/Hor char, Character 

Space setting is not 

possible.

When the orientation is "Vert/Hor char," the character space 

cannot be selected.

No data to paste. Cut or copy the page and prepare the data to be pasted.

Exceeding Memory 

Capacity.

No more characters can be 

entered.

There is insuffi  cient memory to input text. (P.226) Save the 

text data you have created, delete all text displayed on the 

screen, and then enter new text.

Length exceeded.

Input data exceeds cut 

length.

Enter a value within the setting range.

Numbering is already set 

for this page.

The numbering can be set only once per page.

Exceeded character limit. Rework the fi le so that it fi ts within the number of character 

that can be entered.

xxxxxxxx

already exists.

Change the folder name.

Use a diff erent folder name.

Exceeding Memory 

Capacity.

Excessive data are not 

saved.

There is insuffi  cient memory to save the fi le. Increase the free 

space by deleting unnecessary fi les.

No fi les. There are no fi les saved in the printer.
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 Message Details/Solution

No fi les in selected folder. None of the fi les are saved in the selected folder. Select the 

folder again.

99 fi les already exists in 

selected folder.

1 A maximum of 99 fi les can be saved in one folder. Delete 

unnecessary fi les before saving, or save them in a diff erent 

folder.

Exceeded character limit. 

Cannot change.

The character count limit for the specifi ed cut length has been 

exceeded. Change the cut length setting (P.55) or delete 

the characters.

Cannot input.

Change length or character 

size.

Cannot input text with the specifi ed character size and cut 

length. Change the cut length (P.55) or character size 

(P.42).

3 line data setting exists. The page you are trying to divide or combine contains three-

line data. Change or delete the three-line page.

Numbering data setting 

exists.

The page you are trying to divide or combine has numbering. 

Delete the numbering. (P.49)

No character data. You need to have already entered text in advance to display 

the printing preference display. Enter characters before 

pressing the [Print] key.

Data beyond cut length will 

be deleted. OK?

When "Yes" is selected, data exceeding the cut length will be 

deleted automatically.

If you select "No," the deletion will be canceled. Change the 

cut length or the number of characters.

When orientation is Vert/

Hor char, the centerline is 

not printed.

The center line will not be printed on pages where the 

orientation is "Vert/Hor char." If you want to print the center 

line, change the orientation. (P.45)

Close cover and press any 

key.

You cannot print with the cover open. Close the cover and 

press any key.

 Print media isn’t set. Reload the print media correctly. Press the [Enter] key to start 

printing. (P.21)

Depending on the type of tube, the tube may not be 

detected. In this case, set the print media to "Clear Tube" in 

the print settings and print. (P.77)
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 Message Details/Solution

 Ribbon cassette isn’t set. Load the ribbon cassette. Press the [Enter] key to resume 

printing. (P.18)

 End of media.

Pull out print media

The print media ran out during printing. Pull out the print 

media from the printer and press any key. Replace the print 

media with a new one and press the [Enter] key to resume 

printing from the interrupted page. (P.21)

 Replace print media. Load a new print media and press the [Enter] key to resume 

printing. (P.21)

 End of ribbon.

Replace ribbon cassette.

Replace the ribbon cassette with a new one and press the 

[Enter] key to resume printing from the interrupted page.

 Start of media not detect. 

Remove media between 

print head and cutter.

Remove the print media and make sure that the print media 

is not stuck between the print head and the cutter. For 

information on removing print media from between the 

print head and cutter, refer to "If a Tube or Label Tape 

Becomes Jammed (P.206)". After setting the print media 

correctly, press the [Enter] key to resume printing.

Print head position can’t be 

initialized.

Press any key. If the same message appears again, contact 

your place of purchase.

Print head can’t be moved to 

print position.

Cut position can’t be 

initialized.

 Size switch lever is not 

positioned correctly. 

Proceed?

The size of the print media set on the printing preference 

display does not match the position of the size switch lever. 

(P.22)

If you select "Yes," printing will start.

To reset the settings, select "No" and follow the instructions 

on the screen to set the size switch lever to the correct 

position. Press any key to start printing.

Data check.

Resetting completely

An error has occurred in the data and all settings have 

reverted to the settings at the time of purchase. All saved 

fi les have also been deleted.
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 Message Details/Solution

Power turned off  when 

saving fi le.

Checking saved data.

Check the saved fi les. If the data is not saved, re-save it.

Power turned off  when 

loading fi le.

Resetting input data.

The data being entered will be deleted. Re-enter the data.

Power turned off  when 

deleting fi le.

Checking saved data.

Check the saved fi les. If the fi le has not been deleted, delete 

it.

  Feed error

Media is jammed in the 

feeding path.

The print media jammed during printing. Follow the 

instructions on the screen to remove the jammed print 

media. (P.206)

 No ribbon information. 

Ribbon remaining amount 

can’t be displayed.

Information could not be read from the IC chip in the ribbon 

cassette. Or, a ribbon cassette that has already been used up 

has been loaded. 

Press any key and follow the instructions on the screen.

When selecting expansion 

of Plate Print Area, only 

Plate can be printed.

Set the Cut Length to "Automatic." (P.55) 

When the Plate Print Area is set to "Expansion," a print media 

other than plates cannot be selected.

Power cycle the printer. Turn the power back on. If the same message appears again, 

contact your place of purchase.

As warmer temp.

didn’t rise enough, warmer 

was turned off .

Turn off  the printer, and re-set the tube warmer in place 

again. (P.31) If the same message appears again, contact 

your place of purchase.

As warmer temp.

couldn’t be controlled, 

warmer was turned off .

Turn off  the printer and 

check the AC adapter.

Turn off  the power, unplug the AC adapter from the power 

outlet, and then contact your place of purchase.
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 Message Details/Solution

Updating the fi rmware has 

failed. Please try again.

Press any key, and then execute the fi rmware update fi le (.exe) 

again.

Communication error

Reconnect to host device.

Press any key. 

Perform PC connect (or Bluetooth) again to send data.

 Battery is running low. 

OK to continue?

The battery level is low. If you select "Yes," you can continue 

printing. When you have fi nished printing, turn off  the power 

once. After that, replace the batteries or connect the AC 

adapter. 

Wrong cut length

Adjust the length?

When "Yes" is selected, the cut length is automatically 

changed according to the print media.

If you select "No," the cut length will not be changed. Change 

the cut length or the number of characters.

Bluetooth is disconnected. 

Please try again.

Check the Bluetooth status of the printer and the 

communication device, and connect them again.

Exceeding Memory 

Capacity.

Reduce the data size and 

resend.

There is insuffi  cient memory to receive text. (P.226)

Reduce the number of characters and send the data again.

Loading data exceeds the 

cut length.

The excessive data have 

been deleted. 

When a fi le with text exceeding the cut length is inserted 

into data with a specifi ed cut length, if you load it as "text 

only," the characters past the cut length will be deleted, then 

the text will be displayed.
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  Updating the Firmware

New fi rmware is released to add new functions or resolve issues with existing functions. It is 

recommended that you always use the latest fi rmware to improve the functionality and ease-of-

use of the printer. 

 Checking the Firmware Version

Please check the fi rmware version of this product before updating it.

1  Press the [Settings] key.

2  Use [  ] or [  ] to select "Others" and press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

3  Use [  ] or [  ] to select " Device Info.," and then press the [Enter] key.

Others

   Device  Info .

   Page Display
   Counter

4  Check the fi rmware version. 

Item Details

S/N Printer serial number

Main Printer fi rmware version

Font Font version

Bluetooth Bluetooth version

BD Address Bluetooth address

Device Information
S/N
Main
Font

:XXXXXXXXXX
:Ver.XX.XX
:Ver.XX.XX

5  Press the [Shift]+[Canc] keys.

 ● The display returns to the character input display.
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 Running the Firmware Update

IMPORTANT

• Preparing to update the fi rmware.

 - Download the latest fi rmware from the Canon website.

Users in the U.S.A:

https://www.usa.canon.com/internet/portal/us/home/support/

  Users in the South & Southeast Asia:

https://asia.canon/en/support/download

 - Please back up any data you have saved to the product’s storage volume in case the fi rmware 

update is not executed correctly, etc. (P.173)

• Use the AC adapter when updating the fi rmware.

• Multiple printers cannot be updated at the same time. Only one printer should be connected at a 

time, be it an MK5000 or MK3000 model.

• You must be logged in to the computer as a user with administrator privileges.

•  Exit all other running applications.

1 Connect the AC adapter to the printer. (P.12)

2 Connect the printer to the computer with the USB cable.

3 Turn on the printer. (P.15)

4 Press the [Settings] key.

5 Use [  ] or [  ] to select "Others" and press the [Enter] key.

Sett ings

   Others

   Pr int  adjust
   Sett ing

6 Use [  ] or [  ] to select "Firmware update" and press the [Enter] key.

Firmware update

Others
   Counter
   Device  Info

https://www.usa.canon.com/internet/portal/us/home/support/
https://asia.canon/en/support/download
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7 Use [  ] or [  ] to select "Yes" and press the [Enter] key.

 ●  If you select "Yes", the printer will be on standby 

state to receive from the fi rmware update fi le. No
Yes

Firmware update

Please update the
firmware with update
file  v ia  PC.

NOTE

• If you want to cancel the standby state, turn off  the printer.

8 Execute the fi rmware update fi le (.exe) on the computer.

 ● After checking the current fi rmware version and the version of the updater, click [Send].

 ● When the update is complete, the printer will automatically turn off .

IMPORTANT

• Don't do any of the following while updating the fi rmware. 

 -  Turn off  the power.

 - Unplug the USB cable.

 - Operate any component of the printer. 

 - Send data to the printer from an application or a printer driver.

 - Put/allow the computer to sleep (the update may not be performed properly if the computer goes 

into sleep mode.)

•  If any of the following occurs, the update may not have been performed correctly. Please check the 

fi rmware version on your device. 

 - The update may have been interrupted in the event of a power outage, etc. 

 - The "Firmware update complete" dialog box does not appear at least 20 minutes after starting the 

update.

9 After confi rming that the update is complete, close the fi rmware update fi le 

screen.

 ● This completes the fi rmware update.
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 Specifi cations

 Printer

Product name MK5000

Printing method Thermal transfer using one-line head

Resolution 300dpi

Printing speed High speed mode: 40 mm/sec *1

Middle speed mode: 25 mm/sec

Low speed mode: 18.5 mm/sec

Throughput

<Printing conditions>

- Printing media; Tube

- Segment length; 20mm

-  Characters to print; 

Five "3 mm full-width"

- Half cutting

- Cutting strength; Normal

High speed mode (40 mm/sec):

  55 tube segments/min 

  (for ø1.5 mm to ø6.5 mm)

  45 tube segments/min

  (for ø7 mm to ø10 mm)

Middle speed mode (25 mm/sec):

  35 tube segments/min

Low speed mode (18.5 mm/sec):

  30 tube segments/min

Cut length Tube: 8 mm to 150 mm

Label tape/Plate: 4 mm to 150 mm

Ink ribbon Ribbon cassette 

(black: 40 m/150 m, white: 85 m)

Character print size 1.3mm full-width, 2 mm full-width/half-width,

2.6 mm full-width/half-width, 

3 mm full-width/half-width, 

4 mm full-width/half-width, 

6 mm full-width/half-width

Input system Notebook computer keyboard

Display system LCD (160 x 64 dots) with backlight

Number of display characters Input data 10 characters x 2 lines (for full-width)

  Internal memory Printing character data storage of approximately 

5,000 characters

File storage of approximately 250,000 characters

Number of folders: 10
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Cutting method Automatic half cut, Automatic full cut

Power 

supply

AC adapter 

(PR-TP001)
100 to 240 V    50/60 Hz   0.74 A

Rechargeable battery eneloop AA Rechargeable Batteries, Standard Model 

(Model Number: BK-3MCCA (for North America), BK-

3MCCE (for Asia).": 6 pieces

Interface USB2.0 Full-Speed

Bluetooth Specifi cation Version 5.0 (Bluetooth Low 

Energy Technology)

Operating environment Temperature: 15 to 32.5 degrees Celsius *

Humidity: 10% to 85% (no condensation)

* With the tube warmer installed: 5 to 18 degrees 

Celsius

Maximum power consumption 25 W

External dimensions 272 mm (W) x 318 mm (D) x 97 mm (H)

Weight 2.7 kg (not including accessories)

 *1  The printing speed may be slower depending on the type of print media and the environment in 

which you are using the printer.
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 Print Media

The following print media can be used for printing.

 Tube *1

PVC tube ø 1.5 mm to ø 10 mm inside diameter

0.4 mm to 0.6 mm thickness

*  With the tube warmer installed: ø 1.5 mm to 

ø 6.5 mm inside diameter
Clear tube

Heat shrink tube ø 1.5 mm to ø 10 mm inside diameter

0.2 mm to 0.4 mm thickness

Label tape Cassettes (White, Yellow, Silver) in 6, 9 or 12 mm width, 

30 m length (Silver: 27 m length)

Flat tube *1*2 ø 1.5 mm to ø 6.5 mm inside diameter, 11.2 mm or less 

width, 0.4 mm to 0.6 mm thickness

Plate *1*2 0.5 mm thickness, 8.0 mm to 10.0 mm width

*1   Please purchase commercially available tubes and plates for use. Also, some commercially 

available tubes and plates cannot be printed by this printer. Please test the operation on a given 

print media before use.

*2  The optional plate and fl at tube attachment is required.

 System Requirements for Software

Compatible OS Windows 11

Windows 10 (64bit/32bit)

Windows 8.1 (64bit/32bit)

Computer A computer that supports any of the above operating 

systems.

Monitor and video driver 1024 x 768 dots resolution, 

1280 x 1024 recommended.

Free hard disk space required 

for installation (including 

temporary fi le storage)

Application software: 100MB

Printer driver: 100MB

*  Disk space requirements are subject to change without 

notice.
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 Consumable Supplies and Options

Details on consumable supplies and options can be found below.

For details on how to purchase consumable supplies and options, please contact your place of 

purchase.

NOTE

• Please purchase commercially available tubes and plates for use. For more information, refer to "Print 

Media (P.228)".

 ■  Consumable Supplies

 ●   Ribbon cassette  ●   Label tape cassette

Black: 40m/150m, 

White: 85m

Width: 6mm/9mm/12mm

Color: White/ Yellow/Silver

 ●  Cutter set  ●  Cleaner  ●  Plate cleaner

*  Blue

*  For the tube attachment, 

(optional) plate and fl at 

tube attachment (used for 

printing on fl at tubes), and 

(optional) tube warmer.

*  Gray

*  For the (optional) plate and 

fl at tube attachment. (used 

for printing on plates).
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 ■ Options

 ●  Tube Warmer

This device is used to warm up tubes that have become stiff  due to cold. The tube warmer 

allows for clean printing even in low temperature environments.

 ●  Plate and fl at tube attachment

It is used for printing characters on plates or fl at tubes.

* One each of the cleaner (blue) and  plate cleaner (gray) are included.

 ●  Tube attachment  * This component comes packaged with this product.
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  List of Function

The functions that can be set for each function key are as follows. All functions can be set using 

the  [Settings] key.

[Settings] key Connect PC connect [Connect] key  *2

Bluetooth

Distributed Print

ConnectKeyConfi g

Warmer Warmer Control

Warmer Temp.

Character Edit Numbering [Num] key

Symbol

[Symbol 1] key

or

[Symbol 2] key

Page Edit Insert [Edit] key

Delete

Copy

Cut

Paste

Division

Combining

Page Settings  

*1

Character Size [Char Size] key

Frame [Frame] key

Cut Length [Seg Len] key

Alignment

Plate Print Area

All centering

Batch (Cut Length)

Orientation [ ] key

Continuous Print [Cont Print] key

Character Space [Char Space] key

Lines [Set Lines] key

 *1  The order in "Page Settings" may diff er from what is actually displayed on the screen.

 *2 When the [Connect] key is set to "PC or Bluetooth" (default setting).
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Print Settings Half cut [Set Cut] key

Full cut

Plate Full cut

Underline 6, 9

Center Line

Delete All Text only [Del All] key

Text+settings

File Save [File] key

Load

Delete

Print adjust Top position [Adjust] key

Vertical Position

Length

Half Cut Depth

Half Cut Motion

Full Cut Depth

Full Cut Motion

Print density

Settings Print speed

Display contrast

Backlight (ADPTR)

Backlight (BAT)

Sound

Others Remove [Remove] key

Cleaning

Forced full cut

Feed

Replace cutter

Rewind movement

Auto Off  (adapter)

Auto Off  (battery)

Auto Backlight Off 

Print Priority

Init. DeleteCheck

Page Display [Page] key

Counter

Device Info.

Firmware update



233

C
o

n
te

n
ts

Preparation/
Setup

Prin
t U

sin
g

 a 
C

om
p

uter
A

p
p

en
d

ix
In

d
e

x
P

rin
t/S

ave
In

p
u

t/E
d

it
N

am
es of 

Com
ponents

M
aintenance/

Printer Settings
Tro

u
b

le
-

sh
o

o
tin

g

  List of Symbols

<Symbol 1>

<Symbol 2>
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AC adapter  ................................................................................. 12

AC adapter connector  ............................................................3

[Adjust] key  ...................................................................................7

Alignment  ............................................................................10, 55

All line centering  .....................................................................62

Arrow keys  ............................................................................ 7, 37

Auto backlight off  ................................................................197

Auto off (Adapter)  ................................................................193

Auto off (Battery)  ..................................................................193

B

Backlight (ADPTR)  .................................................................196
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[Back Space] key  ................................................................7, 40

Batch setting  .............................................................................63

Battery  .......................................................................................... 13

Battery case  ..................................................................................3

Battery cover  ................................................................................3

Blade receiver  ..............................................................................4

Bluetooth connect  .............................................................. 204

C

[Canc] key  ......................................................................................7

[Caps Lock] key  .............................................................. 7, 8, 38

Center line  ..................................................................................53

Change the function of the [Connect] key  ........... 202

Changing the folder name  ..............................................108
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